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Safety
 Warning
Hazardous voltages, capable of causing injury or death, are present 
in this instrument.  Use extreme caution whenever the top back and 
the bottom covers of the instrument are removed.  Always unplug 
the unit while removing those covers.

Ventilation
The UGA system requires forced air cooling to operate at a reason-
able temperature. Do not block the air inlet or exhaust on the back 
of the unit.  Components will fail without this cooling.

Lifting
The UGA system is heavy; use care when lifting.  Two people are 
recommended for lifting the system.  The handles provided are 
used for lifting. Do not move when system is running.

Line Voltage
The UGA system is specified for line power of either 110 V / 60 Hz 
or 220 V / 50 Hz.  All the components inside the instrument will 
only be operated on 24 VDC.  Operating at other voltages will dam-
age the components.   Two 3 A fuses must be used in the power 
entry module.

Exhaust
As shipped, the UGA system exhausts to the atmosphere.  If the 
system is analyzing hazardous gases, the user must make provi-
sions to handle the exhaust from the system.  A standard 1/4 inch 
ID Tygon tube connection is provided for this purpose.

Elastomer Seals
Silicone has been reported to react adversely and irreversibly with 
the glass contained in an electron multiplier.  Since the UGA con-
tains an electron multiplier, do not use silicone greases or oils on 
seals; use only hydrocarbon based materials. 
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Symbols on SRS products
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Checklist
Open the box(es) and inspect all components of the UGA system.
Report any damage to Stanford Research Systems immediately.
Compare the contents of the shipping boxes against your original 
order and the checklist below.  Report any discrepancies to Stan-
ford Research Systems immediately.

UGA base unit 
Power cord
15’ Ethernet cable
6’ 1/16” OD, 175 mm ID capillary, unheated, with the connector
Links to download UGA/RGA manuals and software

16 port Valve, installed
Valve base, installed
Valve controller, installed
Valve controller holder, installed
Control cord, installed
Power cord for the controller, installed
RS232 communication cord for the controller, installed
Accessory box
Channel plug, 2 pkg
2’ 1/16” OD, 175 mm ID capillary, unheated with connectors for the 
Valve outlet and the UGA sample inlet
3’ 1/16” OD, 175 mm ID capillary, unheated with connectors for  
sampling (2 each)
Top front cover for this option, installed

Vent valve, installed
Purging gas line connector, installed
Vent line tube, installed

TP & controller, installed
Other proper parts; TP power cord, TP control cord, TP commu-
nication cord, TP holder, the Elbow heater insulator box, and the
roughing connector are assembled together with TP & controller
inside the system.

Standard System

Option 1. 
Multiple Inlet Valve

Option 2. 
System Vent Valve

Option 3. 
Hydrogen pumping 
specified TP
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Materials List
SRS receives many requests for information about corrosion compatibility.  It is our policy not to 
state the compatibility of our system with various corrosive environments.  We simply cannot test 
the myriad combinations of environments that our customers use.

We do provide a list of all the materials exposed to the gas being introduced into the system.  Our 
expectation is that users who need to measure corrosive environments already have some type of 
system that creates, handles and contains the corrosive gases.  Given that they have designed and 
operate said system, they are the best people to decide the compatibility of the materials in our 
system with the specific corrosive environment.

The UGA system contains the following materials:

Body
•	 304 stainless steel - high vacuum tube 
•	 316 stainless steel - quarter inch tube and fittings
•	 molybdenum - electrical feedthrough
•	 ceramic - electrical feedthrough
•	 AgCuIn - braze material on feedthroughs
•	 alumina - contained in the RGA
•	 aluminum - body of diaphragm pump

Replaceable Components
•	 glass - if an electron multiplier is installed in the RGA
•	 chromium - surface of the electron multiplier
•	 IrO2•ThO2 - filament of RGA

Seals
•	 copper - seals in the CF high vacuum flanges
•	 316SS - major component of VCR® seals
•	 silver - a thin layer on the VCR® seals to prevent gauling
•	 Viton - o-ring seal in the KF flange
•	 buna-N - seal in the high conductivity valve
•	 neoprene - diaphragms in diaphragm pump
•	 nitrile butyl rubber (NBR) - diaphragm pump valves - backing line
•	 Tygon® - connections to diaphragm pump (can be substituted)
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Inlet	

Type	 capillary: available in stainless steel, PEEK, and glass lined 		
		  plastic
Flowrate	 1 to 10 milliliter per minute at atmospheric pressure
Response time	 <200 ms
Pressure	 selectable from 1 X 10-6 bar to 1 bar
	
Mass Spectrometer	

Type	 quadrupole
Detector	 Faraday cup (FC) &
		  Electron multiplier (CDEM)
Range	 1 to 320 atomic mass units (amu)
Resolution	 <0.5 amu at 10% of peak height
Detection limit	 <10 ppm with Faraday cup detector
		  <1 ppm with electron multiplier
Operating pressure	 10-4 mbar for FC
		  10-6 mbar for CDEM
	
Connections	

Inlet	 1/8 inch Ultra-Torr® fitting
Exhaust	 1/4 inch Tygon tube adapter
Computer	 RS-232C (DB-9 connector) and Ethernet (RJ-45)
Power	 3 pin grounded cable
	
System	

Pumps	 hybrid turbomolecular/drag pump, 81 liter/s, 
		  ultimate pressure 2 x 10-9 mbar
		  diaphragm pump with ultimate pressure less than 1 mbar
		  protection class IP44

Materials 	 (see full materials list for details)	
		  construction: SS304 and SS316
		  insulators: alumina, ceramic
		  seals: Viton, buna-N, and nitrile butyl rubber
		  misc: aluminum, Tygon

Specifications
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General	

Startup time		  5 minutes from full stop

Max. Ambient Operating		  35 °C
Temperature	

Power requirement		  100 - 240 V AC input, less than 600 W total

Dimensions		  28 cm H x 30 cm W x 65 cm D ( 11 in H x 12 in W x 	
			   26 in D ) without Handles	
			   33 cm H x 35 cm W x 67.5 cm D (13 in H x 14 in W x 	
			   27 in D) with Handles

Weight		  41 kg (85 lb. )
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Quick Start
	
	

	

	 Capillary connection 

	
	

This section will describe a quick start procedure for operating the 
UGA and getting air analysis data from a remote PC through an 
Ethernet connection. If you find any damage to the UGA, do not 
proceed and call SRS at the number below. 

For detailed control procedures, please refer to Chapter 2, “Front 
Panel Operation of UGA”.

(For UGA systems with O100HC – Sample Heater Accessory, see
the section of ‘Options and Sample Heater Accessory’ in Chap-
ter 1 of this manual.)

• Pop off the front upper panel by grasping both sides of the panel 
and pulling up (see photo).
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• Unscrew the Ultra-Torr fitting and remove the pin (see photo). 
• Use the pin holder to the right to store the pin.
• Insert the capillary into the Ultra-Torr fitting and tighten. 
• Replace the panel.

• Download the latest UGASoft installer from the SRS website at 
https://thinksrs.com.

• Run the installer and follow the prompts to install the UGA/RGA 
control software. Note that UGASoft is a unique operating mode 
within the larger RGASoft software. In the context of this manu-
al, UGASoft is referred to as the software. The installer file name 
remains RGASoft-<version>.

• Power up the UGA if it is off.

• Set up Ethernet parameters (IP address, Subnet Mask, Gateway,
Username, and Password) properly at UGA. Please refer to the sec-
tion 2.3.3.2 of this manual for detailed information.

	

	 UGA control through a remote PC

	
	

	

Please note!

Administrator account privileges  are required to install the software.  
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• Connect the provided Ethernet cable between the UGA and a
switch or a router which your PC is connected. If your PC is not
connected to Ethernet, then use Serial connection instead (refer to
the section 2.3.3.1 of this manual.)

• Start the UGASoft program (the link is located in the program 
group “SRS RGASoft”). On the first launch of the software, the fol-
lowing welcome message is presented. Check the checkbox “Do 
not show this message again” to hide it the next time.

• In the Connections dialog box that appears at program start-
up, the UGA will be automatically displayed, as illustrated in the 
screenshot below, if a serial connection is used. If an Ethernet con-
nection is used, it must be manually configured in the software. The 
remainder of this Quick Start will focus on the Ethernet connection. 
 
Note that a COM port may take some time to populate, especially 
when it is newly added to Windows. Click “Refresh” if an expected 
COM port is not shown.
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• To start configuring an Ethernet connection in the software, dou-
ble-click an empty table row of the Connections dialog box to bring 
up the Ethernet Connection Settings dialog box. Enter the IP ad-
dress, username and password that configured on the UGA in the 
earlier step.  The default username and password are “SRSUGA” 
and “SRSUGA”. Click OK to save the settings and close the dialog 
box.

• Back to the Connections table, if the UGA is found based on the 
provided information, it will be displayed with status “Available”.

• Select the available UGA and press “Connect”. The software will 
initiate the connection and close the Connections dialog box when 
the UGA is successfully connected.
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• Next, the program will read UGA status and show the present 
state.

• Select menu UGA > Start/Wake to start UGA and wait until the 
System Mode changes to the “Ready” state. The system mode in-
dicator is located in the UGA status/control panel and another one 
near the top of the sidebar/control bar (marked by arrows in the 
screenshot below). It takes about 5 minutes to reach the “Ready” 
state. When ready, the RGA functions and controls are enabled as 
illustrated in the screenshot. The UGASoft is initially configured to 
capture UGA measurements such as chamber pressure, tempera-
ture, etc. These measurements are displayed in the UGA measure-
ments docking window.

If the system fails to reach the “Ready” state, refer to section 2.2.2.4 
of this manual.

	



Stanford Research Systems UGA Series Universal Gas Analyzers

Quick Startxiv

• Make sure the RGA component indicator (marked by the arrow 
in the above screenshot) shows the “On” state.

• Select menu Probe > Turn On Filament to activate the ionizer.

• Click the “play”  icon on the sidebar (or select menu Scan > 
Run) to initiate a scan with the default parameters, an Analog scan 
from 1 to 65 amu. Scan parameters are displayed under the Scan 
Settings and Status tabs (see screenshot). Clicking on one of these 
tabs or the “1 - Analog” tab brings forward the scanning mass spec-
trum which is a rough background spectrum.

• Stop the scan using one of “stop”  icons on the sidebar (or select 
menu Scan > Stop Now, or Scan > Stop at the End).

• If you plan to sample atmospheric pressure, be sure you followed 
the directions under the previous section, “Capillary Connection”.

• To get started for atmospheric sampling, first click the UGA tab 
to bring up the UGA status/control panel (or select menu View > 
Show UGA Status/Control).

• Next, click on the wrench icon of the “Sample Valve” item and 
select “Open” in the pop-up dialog box and click “OK”.

• The UGA will automatically increase the pumping speed of the 

            Start Analog Scan
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roughing pump and turn on the bypass pump.  It will then open 
the bypass valve first and open the sample valve in sequence. 

• The system will read approximately 1.5 torr at the bypass line,   
and  5 X 10-6 torr for the mass spectrometer chamber if you use the 
provided 6’ capillary.

• Start the Analog scan again using the “play”  icon on the side-
bar (or select menu Scan > Run).

• The spectrum of air will be displayed, which can be compared to 
the example below.
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Chapter 1  

UGA Basics

In This Chapter This chapter gives the fundamental information on
using the Universal Gas Analyzer (UGA) series.

1.1 	 Introduction  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                 	 1–2
1.2  	 Configuration  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                	 1–6
	   	 Front panel  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                	 1–6 	
		  Rear panel   .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                 	 1–7
		  Top front components   .  .  .  .  .  .  .  .          	 1–8
		  Top back components   .  .  .  .  .  .  .  .          	 1–10
		  Bottom components  .  .  .  .  .  .  .  .  .  .           	 1–10
		  Covers  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 	 1–12
	   	 Miscellaneous parts  .  .  .  .  .  .  .  .  .  .           	 1–12
1.3  	 Options & Sample Heater Accessory  .  .   	 1–13
	   	 Multiple inlet valve option  .  .  .  .  .  .       	 1–13
	   	 Vent valve option  .  .  .  .  .  .  .  .  .  .  .             	 1–13
	   	 Hydrogen pumping specified
			   Turbomolecular Pump option   .  .    	 1–14
	   	 Sample heater accessory   .  .  .  .  .  .  .         	 1–14
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1.1  Introduction

	
	

	
	

	
	

Universal Gas Analyzer (UGA) series instruments are modern mass 
spectrometers designed for the analysis of light gases. The three 
systems, 120, 220 and 320, differ only in the mass range they can 
detect.  A quadrupole mass spectrometer (also called a residual gas 
analyzer or RGA) performs the task of analyzing the gas.  

The spectrometer operates at high vacuum and therefore, pumps 
are required to draw the gas out of the instrument and maintain 
the vacuum.  A turbomolecular pump (TP) is commonly used to 
generate the high vacuum region (<10-5 Torr) required to operate 
the ionizer and quadrupole of RGA.  The inlet continuously sam-
ples gases at low flow rates (several milliliters per minute) making 
the instrument ideal for on-line analysis.  Not only is data acquired 
continuously (as opposed to batch sampling employed by gas chro-
matographs) but also very quickly.  A change in composition at the 
inlet can be detected in about 0.2 second. The system allows data 
to be collected quickly - a complete spectrum can be acquired in 
under one minute and individual masses can be measured at rates 
up to 25 ms per point.  

The SRS UGA systems enable many new applications where tradi-
tional mass spectrometers were too large and heavy.  More recently, 
a variety of applications for atmospheric sampling were developed 
including fuel cell research, Freon detection, specialty gas produc-
tion monitoring, fermentation process monitoring, and catalysis 
studies.  

To accommodate atmospheric sampling, a pressure reduction 
scheme is required.  A two-stage pressure-reducing inlet samples 
gases at high pressure, reducing them from atmospheric pressure 
to a few Torr at the first stage, and then to a mass spectrometer 
operating pressure (about 10-6 Torr) at the second stage.  In order 
to achieve this performance, most commercially available systems 
employ a capillary tube, pinhole, high vacuum pump (generally 
TP), and single backing pump.  The single backing pump performs 
double duty, evacuating a bypass line (the first stage) and back-
ing the TP (the second stage).  The drawback to this architecture 
is that the bypass flow is recombined with the sample flow at the 
backing pump, which allows backstreaming through the TP.  This 
backstreaming can cause real problems for users measuring low 
molecular weight gases (e.g. hydrogen, helium).  When high con-
centrations of corrosive gases are used, this backstreaming path-
way also allows a higher fraction of the corrosive gas to reach the 
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RGA and TP.  Exposure to corrosives can dramatically shorten the 
usable life of the RGA filament and the TP.  

The UGA systems can be considered as two main subsystems: gas
handling and the analyzer. The analyzer is the quadrupole mass 
spectrometer, which can only operate in high vacuum. The class of
quadrupole mass spectrometer employed belongs to a class referred 
to as residual gas analyzers (RGA). These spectrometers specialize
in large dynamic range measurements of light gases. The gas han-
dling system consists of a capillary, a pinhole, pumps, and valves 
that deliver the sample gas to the analyzer. The UGA employs two
separate diaphragm pumps (DP) for each stage. In this way, the 
high pressure sample line is completely separated from the analy-
sis system.  (see figure 1-1)

In UGA systems, an atmospheric pressure gas sample is drawn 
through a capillary (6 ft of 175 mm ID) which drops the pressure 
by 3 decades.  A small amount of gas sample is drawn by the TP 
through a pinhole (40 mm) which reduces the pressure to about 10-6 
Torr, while most of the inlet gas (about 99.9%) flows directly to the 
bypass DP.   UGA systems are also simple to operate and maintain.  
All the components can be controlled from both front-panel and 

	

	
	

	

Figure 1-1. UGA Schematic
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a remote computer.  The user can directly control all the pumps, 
valves and heaters from the front panel.  A convenient display al-
lows menu-driven operation.  A capacitance manometer, pirani 
gauge, and an ion gauge monitor the status of the system contin-
uously and this data is available on the front panel.  The variety 
of gauges allows the system to automate the pump down proce-
dure and to implement interlocks for unattended fail-safe opera-
tion.  Control of the UGA is governed by a built-in microprocessor. 
This CPU handles all the data flow between the Auxiliary PCB, Ion 
gauge control PCB, TP driver, and RGA to itself and also to a PC.   

The RGA chamber is a six-way cross with 2-3/4” conflat flanges.  
One port is assigned for a user to use the built-in capillary pressure 
reduction system to sample atmospheric pressures.  This capabil-
ity makes it possible to use the UGA as a helium leak detector or 
for other “sniffing” applications.  Two extra ports are available for 
direct connection to various vacuum regions (from 20 Torr to 10-5 
Torr) using the proper connection.  For gas sampling in the 20 to 
10-3 torr range, a low vacuum inlet assembly can be designed using 
appropriately sized tubing (0.063 inch OD to 0.125 inch OD ) and 
a valve.  The assembly can be attached to the port with a 2.75 inch 
CF flange.  Proper ID selection of tubing is necessary, to ensure a 
low enough operating pressure at the mass spectrometer.  For high 
vacuum application (less than 10-3 torr), 1.5 inch OD tubing can be 
attached to the port with 2.75 inch CF flange directly.

The system may be configured with a multiple inlet valve, allowing 
the user to monitor up to 16 different capillaries at various locations 
in their system.  Some ultra high vacuum and ultra clean chambers 
cannot tolerate venting with ambient air because of the water vapor 
present.  An optional valve allows venting with dried nitrogen or 
other gas supply. The entire system is under microprocessor con-
trol to ensure ideal operation of all pumps and valves.  Two heat-
ers (built-in) surround the chamber, and the connection to the TP.  
Bakeouts up to 120 °C can be performed easily and safely - all the 
heaters are under microprocessor control.  Optional heaters can be 
provided for heating the capillary and the sample line up to 100 °C.  
The software controls the UGA and the RGA, graphically displays 
the data, and provides analysis.  

The UGA is designed to be compact.  All the components – two 
diaphragm pumps, one turbo-molecular pump, the chamber, the 
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RGA, three gauges, two solenoid valves, heaters and the insulating 
cabinet, power supplies, and even the multiple capillary inlet valve 
– fit inside an enclosure of 12”(W) X 11”(H) X 25”(L).  The system 
is designed to run in either horizontal or vertical orientation (See 
figure 1-2).  This flexibility in the operating orientation means it can 
fit almost anywhere, even in space constrained labs.  For the verti-
cal orientation, a right angle power cord is recommended, which is 
not supplied from SRS.  (A user should buy the cord: ex. Digi-Key 
AE9887-ND)

	

	

Figure 1-2. UGA operating orientation
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There are two front panels on the UGA: the upper panel and the 
lower panel.  The upper panel has two ports: one for capillary con-
nection, and another for a DB9 connector which connects the cap-
illary heating control cables (heater power and thermocouple ca-
bles).  The lower panel holds two control pads along with one RJ45 
Ethernet connector and an RS232 serial connector.  (Fig. 1-3)

	

1.2  Configuration

	 1.2.1  Front Panel

	

Figure 1-3. Front Panels
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On the rear panel (also in two parts), there are a main power AC 
socket with the main power switch, an electrical ground knob, and 
a fan for the power distribution PCB on the rear upper panel. There 
are 3 terminal block connectors that extend the connectors in the 
back of RGA120 (Refer to RGA120 manual for their functionality).

There are two BNC connectors – an analog out and a user interlock. 
Two exhaust ports for the Bypass pump and the Roughing pump 
are also provided. If the Option #2 is included, a port for the vent 
gas for the vacuum chamber is also available. (Fig. 1-4) 

	 1.2.2  Rear Panel

Figure 1-4. Rear Panel
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In Fig. 1-5a, the main chamber is shown. It consists of a sample line 
set, a cubic chamber, an RGA analyzer, a chamber heater (CHA), 
and a thermocouple.  The sample line set is composed of 1/8”-Ultra-
Torr connector, sample valve (SV), 40 mm pinhole (50 mm pinhole 
for Option #3) port, bypass valve (BV), and bypass line.  The sample 
line set, the RGA analyzer, and the chamber heater are attached to a 
2.75” cubic chamber as shown in Fig. 1-5a.

These components are covered by the heat insulating box.  (Fig. 
1-5b)  

If Option #1 is ordered, a multiple inlet valve and its controller are 
installed here. (Fig. 1-5b)  If O100HC is ordered, a sample line heat-
er (SAM), a sample line heating jacket set, and an Ultra-Torr con-
nection set (heater and insulator) will be assembled as shown in 
Fig. 1-5c.

	

	 1.2.3  Top Front Components

	

	

Figure 1-5a. Top Front Components
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Figure 1-5b. Top Front Area after the heat insulating box is installed

Sample line heater

Sample heating jacket

Figure 1-5c. Picture of the sample line heating assembly

Ultra-torr 
connection set
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This area contains all the power supply related components: RGA 
ECU, a main power supply, an auxiliary power supply, and a power 
distribution PCB. (Fig. 1-6)

This volume houses vacuum control and system control consisting 
of TP connection elbow with its heater (ELB), TP, Diaphragm pump 
for the bypass line (BP), Diaphragm pump of TP backing (RP), Ca-
pacitor manometer (CM), Pirani gauge (PG), Ion gauge (IG), rough-

	 1.2.4  Top Rear Components
	

	 1.2.5  Bottom Components

	

Figure 1-6.Components configuration at top rear

Power Distribution PCB

Main PS

RGA ECU

Aux PS
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ing line, part of bypass line, Main control PCB, Auxiliary control 
PCB, Ion gauge control PCB, TP control PCB, a speaker, and a TP 
cooling fan.  On the elbow, a heater for system baking is attached.  
The elbow area is surrounded with an insulating box. (Fig. 1-7a)  
PVC tubes are used to connect exhaust lines and the system vent-
ing line.

If Option #2 is ordered, a venting valve is shown connected to the 
TP near the fan.  See figure 1-7b. 

Figure 1-7a.Bottom view of UGA - component configuration

Figure 1-7b.Detailed view of the TP vent valve configuration

TP

ELB

BP

RP
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There are 3 covers; Top front cover, Top back cover, and Bottom 
cover. (Fig. 1-8)  If Option #1 is ordered, a different Top front cover 
will be used.  This optional cover has a slot for multi capillaries con 
nection. (See Fig. 1-8b)

A 6’ capillary of 175 mm ID and 1/16” OD is provided for atmo-
spheric pressure sampling.  A 25’ long RS-232 DB9 cable, a power 
cord, and two dowel pins for sample inlet plugging are also includ-
ed.

	 1.2.6  Covers
	

	

	 1.2.7   Miscellaneous parts

Figure 1-8c. Top rear cover

Figure 1-8a. Top front cover Figure 1-8b. Option #1 Top front cover

Figure 1-8d. Bottom cover 
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There are three system options for the UGA. 
-	 Multiple inlet valve option (Option #1), 
-	 Vacuum purging vent valve option (Option #2), and 
-	 Hydrogen specified TP upgrade (Option #3).  
The first two options can be ordered separately and installed by the
user. The third option replaces the normal TP.  SRS recommends 
returning the UGA to SRS for TP replacement. 

Parts : 	

Multiple inlet valve system 
Valve base 
Valve controller
Valve controller holder 
Control cord
Power line 
RS232 comm. Line 
Channel plug 2 pkg. 
Top front cover for Option #1 
2’ 1/16” OD, 175 mm ID capillary, unheated, with connectors for the 
valve outlet and the UGA inlet
3’ 1/16” OD, 175 mm ID capillary, unheated, with a connector, 3 ea 
Self-control accessory box
Related hardware

The multiple inlet valve system is installed on the UGA setup plate 
along with its special holders.  Power line and communication lines 
are connected.  A 2’ long, 1/16” OD, 175 mm ID capillary for the 
main outlet, three 3-foot long same kind capillary, and two chan-
nel plug packages are accessories for this option.  The self-control 
accessory box contains a hand controller and connection cables for 
the multiple inlet valve.  This unit can control the multiple inlet 
valve by itself without the UGA.

Parts : 	

Vent valve
Purge gas line connector 
Vent line tube
150 mm pinhole tube (only for Option #3 case)

1.3  Options & Sample heater accessory

	 1.3.1  Option #1.  Multiple inlet valve option

	 1.3.2  Option #2.  Vacuum purging vent valve option
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The vent valve is installed on the Turbomolecular Pump. (See Fig.
1-7b.) For the case of Option #3, it is installed at the roughing line
and a 150 mm pinhole tube is in the way before the valve to control
the amount of a venting gas input flow. The main controller board
controls the function of this valve. The purge gas line should be
connected at the rear lower panel before the vent valve is used. 

Parts :

Turbomolecular Pump (TP) & controller

This option replaces a normal TP with an upgraded TP, which is 
specialized for pumping low mass molecules, like H2. The proper 
parts; TP power cord, TP control cord, TP communication cord, TP 
holder, the Elbow heater insulator box, and the roughing connector 
are assembled together with TP & controller inside the system.

Parts : 	

Capillary with heater 
Washer thermocouple, #6 
Sample line heater 
Bypass line heat jacket 
Pinhole heat jacket 
Sample line heat jacket 
Sample line heater holder 
Ultra-torr connector heater 
Ultra-torr insulator 
Related hardware

The parts related with this accessory are shown in the following 
pictures (Fig. 1-9 & 1-10).  The full assembly of the O100HC parts is 
presented in Fig. 1-5c.  

Power for the capillary heater is controlled from the auxiliary con-
trol board.  The thermocouples for the capillary and the sample line 
are also connected to the auxiliary control board.  To conserve heat 
from the tip of the capillary to the pinhole, and all the way out to 
the bypass valve, a custom-designed heating jackets and an insulat-
ing block are used.

	 1.3.3  Option #3.  Hydrogen pumping specified TP

	 1.3.4  O100HC. Sample heater accessory
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Fig 1-9. Capillary with heater.  The connector for 
heater power and TC is also shown.

Figure 1-10. Components for sample line heating in O100HC
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In order to change or connect the capillary for this accessory, follow 
the procedure below.

•	  Pop off the front upper panel and take out completely.
•	  Disconnect the heater power and TC cable from the
        	  connectors on the front insulating box if a heated capillary
        	  was connected. (See Fig. 1-11 below.)
•	  Using a long Phillips driver, unscrew the Ultra-Torr
        	  insulator, and move off the insulator. (See Fig. 1-11)
•	  Unscrew the Ultra-Torr fitting and remove the capillary,
        	  if the capillary was connected.
•	  Take out the Ultra-Torr insulator from the removed
        	  capillary, if the capillary was connected.
•	  Pull out the capillary through the capillary heater
        	  if the capillary was connected. TC cable will be also
        	  coming out together.
•	  Put a new capillary with TC on it into the heater and pass
        	  the capillary connector through the front upper panel and
        	  the Ultra-Torr insulator.
•	  Plug into Ultra-Torr fitting and tighten up the fitting.
•	  Screw back the Ultra-Torr insulator.
•	  Connect the heater power and TC cable to the connector.
•	  Pop in the front upper panel. The final set will look like
        	  the picture in Fig. 1 -12.

	

	

Figure 1-11. Ultra-Torr insulator releasing for O100HC capillary change or connection
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Figure 1-12. Final shape of Heated capillary connection
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Chapter 2 

Guide to Operation
In This Chapter This chapter gives the user detailed information 
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2.1	 Introduction

2.2	 Front Panel Operation

	 2.2.1	 Keypads

			   2.2.1.1     Status Keypad

The UGA can be in one of six modes (5 states, 1 function): OFF, 
READY, IDLE, INDIVIDUAL, BAKE, and LEAK TEST.  

Each state can be reached from other states with some restrictions.  
For example, BAKE state can be reached from READY, IDLE, INDI-
VIDUAL, or OFF state.  And LEAK TEST function can be reached 
only from READY, not from any other states.  But during LEAK 
TEST function, the system can go to OFF.  The UGA can be stopped 
from any condition.  The stop command is handled on an emergen-
cy basis.

When the system is at vacuum sufficient to support RGA operation, 
we refer to the state of the system as the “Ready” state.  Careful 
control of the UGA is required to get to the Ready state safely.  This 
is achieved with proper vacuum control.  After the system is in the 
Ready state, it can perform the function of analyzing gas; running 
the RGA and collecting data. The UGA allows automatic control 
and individual control.  Automatic control means that the UGA 
will perform the pre-designed sequences to reach the requested 
state: Ready state by pushing “START/WAKE” button, Idle state 
by pushing “SLEEP” button, Off state by pushing “STOP” button.  
Individual control means that each component of the UGA can be 
controlled individually by pushing a component button.  These two 
control modes are easily interchangeable.  For the detailed opera-
tional schematics, refer to Appendix B, the state diagram.

The left-hand keypad on the front lower panel of the instrument 
indicates the status of the instrument.  It is a flow diagram showing 
which components are active at any given time.  We will refer to 
this keypad as the “status keypad”. 
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This keypad shows the status of components by illuminating LED’s.  
When a component is in the process of changing state, the LED will 
blink while the UGA microprocessor verifies it is safe to actuate the 
component.

Note that the status keypad has several grey rectangular buttons 
associated with the components in the UGA.   These buttons are 
shortcuts to menus that will be shown on the display of the control 
keypad which is beside the status keypad.  You can navigate the 
menu system on the control keypad or use the shortcuts on the sta-
tus keypad for quick access.

 

Fig. 2-1. The Status Keypad

The right-hand pad on the front lower panel of the instrument has 
a display and buttons to display the status or to control the instru-
ment.  We will refer to this keypad as the “control keypad”.  Any 
change to the state of the UGA must be made using this keypad.  
No changes will occur until the user pushes the enter key or auto 
control buttons on the control keypad.  The control keypad has sev-
eral components; each briefly defined below.

		  2.2.1.2     Control Keypad
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Fig. 2-2. The Control Keypad

Display device

The display serves two functions. It presents system information, 
and allows the user to enter menu driven commands.  The default 
function is the information display.  You can select a different dis-
play (pressures, temperatures, etc.) using the menu system; there-
fore we refer to a “selected display” when discussing the menu sys-
tem below. You can also cycle through the info displays (Pressure, 
Temperature, Turbo Pump) via the “Up” or “Down” button.

Level-up button

This button will bring the user to the main menu from the informa-
tion display mode and vice versa.  In the menu tree, this button will 
move the user up one level.

Up / Down buttons          
 
In the menu, this button will move the cursor or change a param-
eter value.
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Enter button

In the menu, this button confirms the selection of a state, a param-
eter, or a submenu item. 

System Error LED

This red LED will be lit when the system has a fatal error.  An ac-
companying error message is shown on the display.  A fatal error 
refers to an error condition that is preventing the UGA from con-
tinuing to operate.  Operation cannot continue until the error is cor-
rected.

Warning LED

This yellow LED will blink when the system has a warning error 
and the error message is shown on the display for 4 seconds.  The 
warning error means the unit can not process a command due to 
the restrictions of the process, a command syntax error, or no com-
ponent installed.  Because the warning does not affect the perfor-
mance of the UGA, there is no error correction needed.

Start / Wake

When the green button is pushed, the green LED beside the button 
will blink.  The UGA will perform an automated pumping-down 
procedure to reach the Ready state.  At the end of the sequence, this 
LED will stop flashing and remain lit.

Sleep

Pushing this button will put the system in an idle state.  This state 
consumes less power and prolongs the useful life of the pumps.

Stop

Pushing this button will cause the UGA to automatically turn off all 
components as quickly as possible.
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	 2.2.2	  Front-Panel Menu System

		  2.2.2.1     Entering the Menu System

		  2.2.2.2     Menu Navigation

You can toggle between the menu system and the selected display 
using the “Level-up” button.  To enter the menu system, push the 
“Level-up” button on the control keypad.  To leave the menu sys-
tem, push the “Level-up” button again from the top menu.  	

Whenever the user makes a change from the control menu, the dis-
play changes from the menu system to the selected display.  From 
non-control menus, the user must hit the “Level-up” button repeat-
edly to return to the selected display as shown in the following 
drawing.  

The UGA menus are navigated by moving a diamond-shaped cur-
sor with the arrow keys on the control keypad.  The UGA menu 
system indicates you are at the bottom of a menu by putting the 
cursor at the last visible menu item.  Likewise, the top of a menu is 
indicated by locating the cursor at the first visible menu item.  Use 
the control pad arrow keys to scroll through menu items.
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The end branch of each control menu tree is a state change menu. 
The UGA indicates a state change menu by showing the current 
state with an asterisk (*). To change the state, move the cursor to 
the desired state and push the “Enter” button. The detailed menu 
tree is summarized in Appendix A.

For most day-to-day operations, use of the automatic pump-down 
and venting functions is adequate.  For times in which an automat-
ed procedure is not desirable, a manual procedure is given below, 
along with the key presses required for quick operation.  Note that 
any automatic procedure will stop if you make a change to the sys-
tem while the procedure is running.  Also note that you can start 
(or restart) an automatic procedure at any time except during leak 
test and system bake.

Note that this procedure can be accomplished automatically simply 
by pressing the green “Start/Wake” button on the control keypad.

1.	 Enter the UGA menu system (push the “Level-up” button
	 on the control keypad).
2.	 Enter the Display menu and select Pressure.
3.	 Push the “Bypass Pump” button on the status keypad.
4.	 Turn on the Bypass Pump (BP) with the control keypad 
	 (you will automatically be returned to the pressure dis		
	 play).
5.	 Wait for the bypass line pressure (read from a capacitance 
	 manometer) to be below 1 Torr; this usually occurs within 	
	 two minutes.  If the condition is not met after two 
	 minutes, the error LED is lit, an error message appears, 
	 and the system is turned off.  This indicates a system leak.  
6.	 Push the “Bypass Valve” button on the status keypad.
7.	 Open the Bypass Valve (BV) with the control keypad. 
8.	 Push the “Roughing Pump” button on the status keypad.
9.	 Turn on the Roughing Pump (RP) with the control keypad.
10.*	 Wait until the roughing line pressure (read from the Pirani 
	 gauge) is below 5 Torr.  Note if this condition is not 
	 achieved within 5 minutes, the error LED is lit, an error 
	 message appears, and the system is turned off.  This 
	 indicates a leak in the system.  
11.	 Push the “Turbo Pump” button on the status keypad.

		  2.2.2.3     Automatic versus Manual

		  2.2.2.4     Manual Pump Down Procedure
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		  2.2.2.5     Base Pressures

12.	 Turn on the Turbomolecular Pump (TP) with the control 
	 keypad.  The TP speed can be checked in the TP display.  		
	 Push the up or down arrow button to see the TP 
	 information during the pressure display.
13.	 Watch the turbo pump speed on the TP display.  Wait until		
	 the TP reaches full speed (81 kRPM).  Note if this condition		
	 is not met after 10 minutes, the error LED is lit, an error 
	 message appears, and the system is turned off.  This 
	 indicates a leak in the system or a bad TP.  
14.	 Push the “Bypass Valve” button on the status keypad.
15.	 Close the Bypass Valve (BV) with the control keypad.
16.	 Push the “Bypass Pump” button on the status keypad.
17.	 Turn off the Bypass Pump (BP) with the control keypad.
18.	 Push the “RGA” button on the status keypad.
19.	 Turn on the RGA with the control keypad.
20.	 Wait for 4 minutes to turn on the ion gauge (IG).
21.	 Push the “Ion Gauge” button on the status keypad.
22.**	 Turn on the IG with the control keypad.
23.	 At this point it is safe to put the roughing pump in idle  	
	 mode.  This prolongs pump life.  Push the “Roughing
	 Pump” (RP) button on the status keypad.
24.	 Change the RP to the idle state with the control keypad.

* At the step 10, sometimes UGA gives the error 102 (RP too high) 
when the system is turned on for the first time or turned on after a
long turning off period. This happens usually in humid environ-
ment. In this case, the longer BP & RP pumping period at the start
is required. In the control menu, go to ‘Pressure Interlock’ menu. 
Make this off. And repeat the procedure up to the step 10 and wait
until RP goes down to below 1 torr or for a couple of hours. If this 
doesn’t happen in an hour, the error is real. Please check the leak.

** At the step 22, sometimes UGA gives the error 105 (IG too high)
when the system is turned on for the first time or turned on after a
long turning off period. Do the same things written above. If this 
does not solve the problem, the error is real. Please check the leak
or TP performance.

Once the system is pumped down, these approximate base pres-
sures should be realized under the given conditions.  Note that if 
lower base pressures are required, baking may be necessary.  



Stanford Research Systems
UGA Series Universal Gas Analyzers

Guide to Operation2 – 10

UGA Settings Case Pressure ranges

RP idle
TP full speed
IG on
RGA on

General Ready state RP : < 1.0 Torr
BP : maximum read-
ing (10 Torr)
IG : < 1.0 x 10-6 Torr

RP idle
TP full speed
IG on
RGA on
BP on
BV open
SV open
6’ 175 mm ID 
   capillary attached

Atmospheric gas in-
take

RP : < 1.0 Torr
BP : ~1.5 Torr
IG : 5.0 ~ 8.0 x 10-6 
Torr

Note that this procedure can be accomplished automatically simply 
by pushing the red “Stop” button on the control keypad.  This pro-
cedure assumes the UGA is currently sampling atmospheric pres-
sures.  And the ‘Auto Sample Valve’ is assumed to be off. (Refer to 
the page of 2-16 in this chapter.)

1.	 Push the “Sample Valve” (SV) button on the status keypad.
2.	 Close the SV with the control keypad.
3.	 Push the “Bypass Valve” (BV) button on the status keypad.
4.	 Close the BV with the control keypad.
5.	 Push the “Bypass Pump” (BP) button on the status keypad.
6.	 Turn off the BP with the control keypad.
7.	 Push the “RGA” button on the status keypad.
8.	 Turn off the RGA with the control keypad.
9.	 Push the “Ion Gauge” (IG) button on the status keypad.
10.	 Turn off the IG with the control keypad.
11.	 Push the “Turbo Pump” (TP) button on the status keypad.
12.	 Turn off the TP with the control keypad.
13.	 Wait for two minutes to allow the TP to spin down.
14.	 Push the “Roughing Pump” (RP) button on the status 
	 keypad.
15.	 Turn off the RP with the control keypad.

If the vent valve option is installed and the ‘Auto Vent’ is set to be
on, the vent valve will be open when the RP is off. If the ‘Auto Vent’    

		  2.2.2.6     Manual Venting Procedure
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		  2.2.2.7     Manual Sleeping Procedure

		  2.2.2.8     System Bake

is set to be off, the vent valve can be turned on manually by pusing
RP button and selecting the vent valve (VV) there.   (Refer to the 
pages 2-14 & 2-16 of this chapter.)  If VV is not installed, wait until
the TP stops completely to open the chamber.

Note that this procedure can be accomplished automatically simply 
by pushing the yellow “Sleep” button on the control keypad.  This 
procedure assumes the UGA is currently sampling atmospheric 
pressures. And the ‘Auto Sample Valve’ is assumed to be off. (Refer 
to the page of 2-14 in this chapter.)

1.	 Push the “Sample Valve” (SV) button on the status keypad.
2.	 Close the SV with the control keypad.
3.	 Push the “Bypass Valve” (BV) button on the status keypad.
4.	 Close the BV with the control keypad.
5.	 Push the “Bypass Pump” (BP) button on the status keypad.
6.	 Turn off the BP with the control keypad.
7.	 Push the “RGA” button on the status keypad.
8.	 Turn off the RGA with the control keypad. (If the stability 
	 of RGA is concerned, the user can let the filament of RGA 
	 on during idling.  The user may skip these RGA steps.)
9.	 Push the “Ion Gauge” (IG) button on the status keypad.
10.	 Turn off the IG with the control keypad.
11.	 Push the “Turbo Pump” (TP) button on the status keypad.
12.	 Set idle for the TP with the control keypad.
13.	 Wait until the TP spins down to the idle speed.
14.	 Push the “Roughing Pump” (RP) button on the status 
	 keypad to check the status.
15.	 If the RP status is not the idle state, set the RP idle with the 
	 control keypad.

In order to get the ready state from the idle state (WAKE), sim-
ply turn on the TP as stated in  the manual pump-down procedure 
above and turn on the RGA and the IG.  

When the bake command is issued, the heaters for the RGA cham-
ber (the cube) and the elbow adapter (between the cube and TP) 
are on and heat up the chamber and the elbow to the specified tem-
peratures.  This command can be accessed by pushing the Sample 
Heat button or in the main menu tree.



Stanford Research Systems
UGA Series Universal Gas Analyzers

Guide to Operation2 – 12

1.	 Push the “Level-up” button to enter the main menu of 
	 UGA.
2.	 Select “System Bake”.
3.	 Select “Bake Time”.
4.	 Set the baking time in hours (2-100) and press Enter.
5.	 Select “Bake Temperature”.
6.	 Select “Elbow”.
7.	 Use the arrow keys to set the elbow bake-out temperature 		
	 (40 - 120 °C) and press the enter key.
8.	 Select “Chamber”.
9.	 Use the arrow keys to set the chamber bake-out        		
	 temperature (40 - 120 °C)and press the enter key.
10.	 Select “On” and press the enter key to start the bake out.

The display will show the time remaining on the bake, the tempera-
ture of the elbow and chamber.

Note that because the user can enter the system bake from any state
except leak test, the UGA will automatically configure itself for a 
system bake. During this process, the system bake LED will blink 
and the sample heat LED is off. After the UGA reaches the proper 
setting, the sample heat LED will be lit and the system bake LED 
will remain lit. At the end of the bake, the UGA will turn off the 
heaters and will return to the ready state by turning on the RGA 
and the IG.

The UGA can perform a software-independent (stand-alone) leak 
test from the front panel.  When the UGA is engaged in the Leak 
test function, however, this function will block RGA communica-
tions from a remote PC until it is ended.  UGA control software 
will show RGA and Current Mode LEDs are flashing and indicates 
the current mode is Leak Test.  Only the front panel can control the 
Leak test function.  And this function only starts when the UGA is 
in the Ready state.   The Leak test function can check for gas leaks 
from a system under test, sniff from a pressurized system or helium 
leak test from an evacuated system attached to the RGA chamber.

		  2.2.2.9     Leak Test
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	 2.2.3	 Options and Sample Heater Accessory

		  2.2.3.1     Multiple inlet Valve

Leak test Procedure

1.	 Push the “Level-up” button to enter the main menu of
	 UGA.
2.	 Select “Leak test”.
3.	 Select “Mass Selection”
4.	 Use the control keypad arrow keys to choose the mass (in 		
	 AMU) and press the enter key.
5.	 Select “Audio Volume”
6.	 Select the desired volume level and press the enter key.
7.	 Select “Electron Multiplier” (EM).
8.	 Select On and press the enter key to turn on EM.
9.	 Select “On”

The resulting leak test display will show the mass setting, the sen-
sitivity level, the volume level and the detected partial pressure.  A 
bar graph on the last row of the display indicates relative signal in-
tensity.  To change the sensitivity, use the up and down arrow keys 
of the control keypad. 

The analog out BNC on the rear panel of the UGA will give a volt-
age proportional to the leak signal.  The logarithmic value of this 
level is converted to an analog voltage signal from 0 to 10 VDC; 0 V 
for 1x10-14 Torr and below, 5 V for 1x10-9 Torr, and 10 V for 1x10-4 
Torr and above.  (Vdc = log10P(torr) + 14,  P(torr) = 1x10-14 x 10Vdc)   
The audio frequency and pitch is also proportional to the bar graph 
level in its own level.  This audio indicator helps to check for leaks 
when a user can not see the front panel.  The audio can be turned 
off by selecting ‘Off’ in the Audio menu.

Note that under leak test, the automatic keys Start and Sleep do not 
function.  The Stop key functions in any mode.

When the button for Multiple inlet valve on the front panel is 
pushed, the Controls menu will display the present channel of the 
valve.  You can change channels using the Up or the Down buttons. 
After the confirmation button is pushed, the valve will rotate to the 
new position and the display returns to the pre-selected display.
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On the front panel, click the Roughing Pump button to enter the RP 
control menu tree.  The last item is the vent valve.  Choose “Close” 
or “Open” as desired.  

When “Open” is selected, initially the UGA opens the valve for 1
second, then closes the valve. After 40 seconds, the UGA will open it 
again for a minute to vent the system. After the one minute period, 
the valve closes again. This sequence allows TP to stop smoothly 
without a pressure shock. It helps the system to stop safely in sev-
eral minutes and to protect the RGA chamber from contamination.

With the option 3 of UGA, a normal Turbomolecular Pump (TP)
will be replaced with an upgraded TP, which is specialized for
pumping low mass molecules, like H2. The related parts will be
assembled together at the factory. However, operational function-
alities are exactly same as those of a normal TP.

In the sample heaters accessory two heaters--the capillary heater 
and the sample line heater--will be added to the UGA system.  The 
heating temperatures can be set from 40 °C to the maximum of 
100 °C. This temperature limit is important for the valves’ (Sample 
valve & Bypass valve) performance.  

On the front panel, click the Sample Heat button to enter the heater 
control menu tree.  Here the users can set the temperatures of the 
sample heaters (the capillary heater and the sample line heater) in-
cluding other two heaters (the chamber heater and the elbow heat-
er) and turn on the sample heaters.

The UGA has several interlocks to protect the instrument.  There are 
interlocks tied to pressure and temperature.  For example, the TP 
cannot be turned on until the roughing line pressure is low enough.  
If the TP temperature reading is above 60 oC, the UGA shuts down 
the turbo pump and other components to reach a safe state.  The 
following table summaries the interlocks used.

		  2.2.3.2     Vent Valve

		  2.2.3.3     Hydrogen pumping specified TP

		  2.2.3.4     Sample Heaters

	 2.2.4	 Advanced Operation

		  2.2.4.1     Interlocks
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		  2.2.4.2     User Interlock input

	

As can be seen in the table, CM and PG readings (BP and RP dis-
play respectively) are critical for UGA operation.  If either of these 
gauges is malfunctioning, the UGA is not  operable.  If an interlock 
activates, an error message is produced.  For a list of all UGA error 
messages, please refer to the chapter 4.

Interlocks
Action Conditions
BP off CM reading (BP display) above 1.5 Torr 

during start up
BV close CM reading (BP display) above 1.5 Torr 

with SV closed
RP off PG reading (RP display) above 5 Torr 
TP off PG reading (RP display) above 2 Torr, 

TP temperature reading above 60 oC
IG off IG reading above 2.1x10-5 Torr 
SV close CM reading (BP display) above 5 Torr  

or below 0.5 Torr with SV on

There are several other operational restrictions for control of the 
components. For example, the RGA will not be on when TP is not 
at full speed or in the idle state during the auto controls. When the
status of a component is set to change, the UGA checks the present
conditions to determine whether the action would be allowed. If 
an action is disallowed, a warning message is generated and the 
warning LED will blink for 4 seconds. Detailed explanations of all 
the warnings are listed in the chapter 4 in this manual.

The pressure interlocks listed above are in place to maintain safe 
operation of the UGA. Under certain conditions, users may desire 
to defeat the pressure interlocks. Enter the UGA main menu tree 
and navigate to ‘Controls’>’Pressure Interlock’. Select “Off” and 
press the enter key. Only manual control is possible while the pres-
sure interlocks are defeated. Running the UGA with its interlocks 
defeated can damage the UGA. Only experts should attempt to run
with the interlocks defeated.

A BNC connector on the rear lower panel allows a user-defined in-
terlock.  It behaves as an emergency shut down switch when it re-
ceives a TTL low signal.  In any state of the UGA, it stops the system 



Stanford Research Systems
UGA Series Universal Gas Analyzers

Guide to Operation2 – 16

completely.  By using this BNC connection with a user’s external 
equipment,  the UGA can be safely shut down if an emergency oc-
curs.  

SRS has already set default values for the power consumed by the
diaphragm pumps. These levels are a good overall compromise 
between conserving pump life and maintaining good vacuum. Ad-
vanced users may wish to change the level of power consumed by
the pumps. To tune the power level used by the pumps, navigate 
to the pump tuning menu, select the level with the arrow keys and
press the enter key. This function work whether the pumps in on,
idle, or off. 

If the Auto sample valve option is set to be on, the sample valve 
state controls all the components of the sample line.  When the user 
opens the sample valve, the system does everything necessary to 
reach a state in which the valve may be opened.  This may require 
turning on the bypass pump, and opening the bypass valve before 
opening the sample valve.  When the sample valve is closed, the 
system closes the valve, but also closes the bypass valve and shuts 
off the bypass pump.  The default setup is on.  One can change the 
setting using the sample valve menu.  Click the “Sample Valve” 
button.  Then choose the “Auto Sample Valve” item to change the 
setting.  The UGA control software also controls this option.

If the Auto vent valve option is set to be on, the TP vent valve will 
open whenever the RP stops.  This happens automatically as part 
of the stopping procedure.  Sometimes users do not want this auto-
matic behavior and would like to handle the vent valve manually.  
In this case, the Auto vent valve option should be set to be off.  The 
RP button has a shortcut to the vent valve control.  The default is 
on.  The UGA control software also controls this option.

		  2.2.4.3     Diaphragm Pump Tuning

		  2.2.4.4     Auto Sample Valve

		  2.2.4.5     Auto Vent Valve
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2.3	 Remote Operation

	 2.3.1	 Overview

	 2.3.2	 Software Installation

The software controls the whole UGA system and provides many 
data acquisition modes, which should fulfill the needs of most us-
ers. This user manual discusses those aspects of the instrument 
that are relevant to controls of UGA and data acquisition from the 
RGA. 

A full featured software application included with the instrument  
provides an intuitive graphical user interface to the controls (See 
figure 2-3).  All pumps, valves and heaters can be controlled from 
within the software.  Every operation that takes place (valve open 
or close, pumps turned on or off, heaters activated, etc.) is logged as 
a time stamped “event” by the software.  The event log is stored as 
a file on the PC hard drive.  This log can be very useful for trouble-
shooting: if a user finds the UGA’s interlocks activated while he was 
away, the event log will show what gauge registered an overpres-
sure and when.  This allows the user to track exactly where a prob-
lem began instead of guessing what went wrong.  This can save 
hours of time in debugging a vacuum process.
 
In order to obtain RGA data, the UGA needs to be connected to 
a PC.  This means that even though the system can be operated 
from the front panel, software will be used to analyze the gas sam-
ple.  SRS provides an integrated software to control both UGA and 
RGA, and also to handle the analysis.  By installing the application, 
a user can control the experiment remotely.  Generally, the soft-
ware mimics the front panel controls; there are auto control and 
individual control modes.  It also displays system status. The soft-
ware supports both RS-232 and Ethernet remote interfaces. 

In this section, software installation is explained in detail.  The  lat-
est software package is available for download from the SRS web-
site (https://thinksrs.com). Make sure to install the software with 
administrator account privileges.
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Installation of UGA/RGA software:

1.	 Download the latest UGASoft installer from the SRS  
	 website at https://thinksrs.com. Unpack the ZIP package.
2.	 Double click the file RGASoft-<version>-x64.exe to run  
	 the installer. Note that UGASoft is a unique operating  
	 mode within the larger RGASoft software. In the  
	 context of this manual, UGASoft is referred to as the  
	 software. The installer file name remains  
	 RGASoft-<version>.
3.	 Follow the prompts to install the software. In a Windows  
	 system, with default settings, the software will be installed  
	 to “C:\Program Files\Stanford Research Systems\ 
	 RGASoft”, the program group is named “SRS RGASoft”.
4.	 Select the “UGASoft” link to launch the software. It is  
	 located on the desktop (if added in the installation) and in  
	 the program group “SRS RGASoft”. Figure 2-3 shows a  
	 screenshot of a startup window.

	

Fig. 2-3 Screenshot of the initial window of UGA control software.
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	 2.3.3	 Connection to a PC

		  2.3.3.1	    RS232 Serial Connection

In order to use this program, at least one UGA must be connected 
to the PC.  There are two ways to connect the UGA to a PC; TCP/IP 
Ethernet or an RS232 serial connection.  In this section, step-by-step 
instructions are provided for setting up communication. 

The communication between UGA and a PC through RS232 seri-
al connection is possible with two different baud rates: 28800 and 
38400.  The baud rate of 38400 is for a general COM port commu-
nication between UGA and a PC. The 28800 baud rate is used for 
direct communication between the RGA and the PC.  A user can 
select either baud rate from the front panel.  

1.	 Connect between UGA and a PC using the provided serial 		
	 cable.

2.	 Power up the UGA.

3.	 From the front panel choose the baud rate as follows.  The 		
	 default rate is 38400.

•	 Push the “Level-up” button  to enter the UGA menu.
•	 Select “Setup” with the Down button and confirm it.
•	 Choose “Communication” to move to the next menu  
	 tree.
•	 Choose “RS232 Baud Rate”.
•	 Choose the desired baud rate at the menu.
•	 Push the “Level-up” button several times to escape  
	 the menu.

4.	 Make sure the COM port is recognized by the PC. In a  
	 Windows system, refer to the Device Manager > Ports for  
	 details. If a USB-to-serial adapter is used, make sure its  
	 driver is properly installed.
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5.	 Launch the app using the “UGASoft” link on the desktop  
	 (if added in the installation) or from the program group  
	 “SRS RGASoft”. The Connections dialog box will appear  
	 and automatically search for the UGA. Figure 2-4 shows a  
	 typical serial connection in the Connections dialog box. 
 
	 Note that a COM port may take some time to populate,  
	 especially when it is newly added to Windows. Click  
	 “Refresh” if an expected COM port is not shown.

�

	 Fig. 2-4. Screenshot of ‘Serial’ connection in the  
Connections dialog box.

6.	 Select the COM port that shows the UGA with the  
	 “Available” status, and press “Connect”. The software will  
	 initiate the connection and close the Connections dialog box  
	 when the UGA is successfully connected.

7.	 Next, the program will read UGA/RGA  status and show
	 the current state. Figure 2-5 shows a UGA in ready state. 
	 Now a user can explore the program for UGA and RGA 
	 controls and analysis.
 
8.	 For operation of a UGA, refer to section “Front Panel  
	 Operation” (Section 2.2).  The UGASoft program mimics the  
	 functions of the front panel.  For software displays and  
	 controls of UGA, refer to section “UGA Displays and  
	 Controls” (Section 2.3.4).
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Fig. 2-5. Screenshot of UGA controls and measurements after a successful serial connection.
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In order to use this connection, the user should know the network 
environment for the UGA and the PC.  The UGA firmware and soft-
ware both need proper TCP/IP parameters. The setup is required 
on two ends: the UGA unit and the UGASoft program.

The Ethernet parameters on the UGA can be input directly using 
the unit’s front panel or remotely using the software. Following 
steps describe both ways:

1.	 First, determine the IP address, Subnet Mask, and Gateway
	 for communication.  The following are default values.  
	 Refer to your network adminstrator for appropriate values
	 for your network.

	 IP address:	 0.0.0.0
	 Subnet Mask:	 255.255.255.0
	 Gateway: 	 0.0.0.0

2.	 Once you obtain these parameters, enter them through the
	 front panel with the following procedure.  Alternatively, a
	 user may type in these parameters through RS232 serial
	 communication.

Option 1 - Setup from the UGA front panel:

•	 Power up the UGA.
•	 Push the “Level-up” button to enter MENU at the front 
	 panel.
•	 Select “Communication” and hit the confirmation buttom.
•	 Ethernet items are now shown on the display.
•	 Choose “IP Address”.  The display shows the default IP 
	 address.  
•	 Using the “Up” or “Down” button, change the value  Then
	  hit the confirmation button,   .
•	 The next number will be blinking.  Repeat as above to set 		
	 the proper value.
•	 After keying in all four numbers, the display will move 
	 up to the Ethernet menu.  Choose “Subnet Mask” and set 		
	 the parameters.
•	 Follow the same procedure for the “Gateway” item.
•	 Push the “Level-up” button several times to escape the 
	 menu tree and enter the display mode.

	 2.3.3.2	      TCP/IP Ethernet Connection

		  2.3.3.2.1      Ethernet Setup on UGA Unit
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Option 2 - Setup from the RS232 connection:

After UGASoft is connected through the RS232 serial port, the 
TCP/IP parameters (IP address, Subnet Mask, Gateway, User ID, 
and Password) can be typed in from the software using the “UGA 
Ethernet Setup” menu. The “UGA Ethernet Setup” menu is visible 
only when the serial port connection is activated. Follow the steps 
below to enter TCP/IP parameters:

•	 Connect to the UGA via the serial port (refer to the previous 
	 section “RS232 Serial Connection”).
•	 Select menu UGA > Set Up UGA Ethernet. Note that the 
	 “Set Up UGA Ethernet” menu item is visible only when 
	 the serial port connection has been established (See Fig. 
	 2-6).
•	 The “UGA Ethernet Setup” dialog box will appear. Existing 
	 information from the UGA is populated.
•	 Provide the static IP address, Subnet Mask, and Gateway 
	 information. Modify the login credential as desired. The 
	 default login name and password are “SRSUGA” and 
	 “SRSUGA”.

•	 Press OK to save and close the dialog box.
•	 Disconnect the serial connection from the program (menu 
	 File > Disconnect UGA), remove the RS-232 cable from the 
	 UGA unit, and plug in the Ethernet cable. Do not keep both 
	 cables connected. It may cause a failure in instrument 
	 searches.

Fig. 2-6. Screenshots to open UGA Ethernet Setup dialog box.
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The software requires the same Ethernet information that the user 
enters on the UGA unit to connect to it. This is a one-time setup. 
The connection configuration is saved in the system registry and is 
used on every software launch.

1.	 Make sure the UGA and the PC are both connected to a  
	 same network using the provided Ethernet cable. If the  
	 connection is active, the yellow LED on the RJ45 connector  
	 will be lit. 

2.	 Launch the software using the “UGASoft” link if it is not  
	 opened. If the software is already launched and the  
	 Connections dialog box (Fig. 2-7) is closed, open it up again  
	 by selecting menu File > Connect UGA.

	
Fig. 2-7. Connections dialog box.

3.	 Double click an empty table row to bring up the Ethernet  
	 Connection Settings dialog box (Fig. 2-8).

	
	      Fig. 2-8. Ethernet Connection Settings dialog box.

		  2.3.3.2.2      Connection Setup on the Software
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		  2.3.3.2.3      Making TCP/IP  Ethernet Connection

4.	 Provide the IP address, username and password that  
	 configured on the UGA. The default username and  
	 password are “SRSUGA” and “SRSUGA”. Click OK to save  
	 and close and dialog box. This step concludes the setup.  
	 Refer to the next section to make the connection.

After the Ethernet setup is complete on the UGA and in the soft-
ware, the UGASoft program is ready to communicate with the 
UGA. Follow the steps below to establish a connection to the UGA:

1.	 Make sure an Ethernet cable is connected between the UGA  
	 and the PC. Disconnect the RS232 cable if it is connected. 

2.	 Open the Connections dialog box via menu File > Connect  
	 UGA if it is not opened. The Connections dialog box  
	 automatically searches for UGA units using the IP address  
	 and login credential provided in the section 2.3.3.2.2  
	 (Connection Setup on the Software). Press “Refresh” if the  
	 UGA information is not populated. A sample of a found  
	 UGA unit is illustrated in Figure 2-9.

							�      

	
           Fig. 2-9. A UGA is found via Ethernet connection.
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3.	 Select the found UGA with status “Available”, and press  
	 “Connect”. The software will initiate the connection and  
	 close the Connections dialog box when the UGA is  
	 successfully connected. 

4.	 Next, the program will read UGA status and shows the   
	 current state. If the RGA state is “On”, RGA status is also  
	 queried and its functions are enabled on the software.  
	 Otherwise, RGA functions and controls are disabled. 

5.	 Now a user can explore the program for UGA and RGA  
	 controls and analysis. For operation of a UGA, refer to  
	 section “Front Panel Operation” (Section 2.2). The  
	 UGASoft program mimics the functions of the front panel.  
	 For software displays and controls of UGA, refer to section  
	 “UGA Displays and Controls” (Section 2.3.4).

Fig. 2-10. Screenshot of UGA controls and measurements after a successful 
Ethernet connection.
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		  2.3.3.2.4      Troubleshooting an Ethernet Connection

	 2.3.4	 UGA Displays and Controls

An Ethernet connection in the Connections dialog box may show a 
status either “Available”, “Unavailable” or “Error”.  An “Available” 
status means the instrument is ready to connect.  A “Unavailable” 
status means the instrument is reachable but being occupied. An 
“Error” status means the instrument is not reachable. Placing the 
mouse cursor over the status Error will show more error details. 
See the table below for some commomly encountered errors.

Error Probable Cause
Socket operation timed out UGA is offline.
Network operation timed out UGA is online but login failed 

(username/password may be 
incorrect). OR UGA may be 
connected to the computer via 
both serial and Ethernet cables. 
Use one method only.

The UGASoft program provides an integrated user interface (UI) 
containing functions and controls of both UGA and RGA systems. 
The UI is composed of several areas - menu, side bar, control panel, 
docking windows, etc (Fig. 2-11). Following sections focus on the 
displays and controls of UGA components. For functions and con-
trols of the RGA, please refer to the RGA manual or the software’s 
Online Help for detailed information.
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1: Main menu
2: Side bar (control bar)
3: UGA status & control panel
4: UGA Message Board
5: State indicators and controls for components and options
6: UGA Measurements docking window
7: Pressure timeplot of some UGA components
8: Temperature timeplot of some UGA components
9: UGA measurements presented in a table

The UGA menu houses UGA main controls. The menu items are 
enabled or disabled based on the state of the instrument. Main con-
trols include:

		  2.3.4.1	    UGA Control Menu

Fig. 2-11. Annotation of the UGA user interface.
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• Start/Wake: This action initiates the automated START sequence 
to turn on components or to wake them up, bring the instruments 
to the READY state.

• Sleep: This action initiates the SLEEP mode which puts the UGA 
to IDLE state from READY state.

• Shut Down: This action initiates the STOP mode to turn off all the 
components according to the automated STOP sequence.

• Turn On|Off System Bake: Select this action to turn the system 
bake mode on or to turn it off if the system bake is in progress. This 
menu item along with other heating items are not visible for UGA-
LT model since this model does not support heating.

• System Bake Settings: This action brings up the System Bake Set-
tings dialog box to configure temperatures and baking time which 
are used in the System Bake.

• Turn On|Off Sample Heaters: Select this action to turn on or off 
the sample heaters. Heaters can be controlled individually in the 
Sample Heater Settings.

• Sample Heater Settings: This action brings up the Sample Heater 
Settings dialog box to configure temperatures for heaters. Heaters 
can be turned on or off individually.

• Read UGA Measurements: When enabled, this option instructs 
the program to query measurements from the UGA. Measurements 
include temperatures and pressures from various components. 
These measurements are shown in the UGA Measurements dock-
ing window.

• Enable Auto Sample Valve: If the sample valve is opened with 
this option enabled, the UGA turns on the bypass pump, and opens 
the bypass valve, before opens the sample valve automatically. If 
the sample valve is closed with this option enabled, the UGA closes 
the sample valve and bypass valve sequentially, and turns off the 
bypass pump. If the option is not enabled, the sample valve can 
only opened when the bypass valve is open, otherwise the UGA 
will generate a warning.

• Enable Auto Vent Valve: If enabled, the vent valve will be opened 
at the end of the automated STOP sequence, right after the rough-
ing pump is stopped. If not, the STOP sequence ends without open-
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ing the vent valve.

• Set Up UGA Ethernet: This menu item is visible only when the 
UGA is connected via a serial connection. This action brings up the 
UGA Ethernet Setup dialog box which allows configuring UGA 
Ethernet settings remotely.

• Refresh Status: This action forces updating UGA components 
with a latest status.

The UGA components status and control provides insight of the 
system current state as well as a way to change to a desired state. 
The items are grouped together in a panel which is located second 
to the left of the application main window as marked in Figure 2-13. 
Selecting the UGA tab to activate this panel also brings forward 
the UGA Measurements docking window. To activate the UGA tab 
from the main menu, select View > Show UGA Status/Control.

		  2.3.4.2	    Components Status & Control

Fig. 2-12. UGA main menu
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The state of a component is represented with an LED icon and a 
brief description. Clicking on the wrench icon brings up the dialog 
box to change the state of the component. If a state is restricted to 
change, it will be disabled in the dialog box.

The panel is divided into 4 groups:

• System Status: These items show high level status of the system. 
They are ready-only. The System Mode shows the current system 
state: Off, Ready, Sleep, Leak test, System bake, or Manual control. 
It also shows transition states. The System Error and Warning in-
dicators blink when an error or warning is detected. The event is 
logged in the Message Board.

• Components: These are standard components that are equipped 
with the UGA. The component list can be different for different 
models. The number beside the “Ion Gauge” text indicates which 
filament the ion gauge is using. There are two filaments in an ion 

Fig. 2-13. UGA status/control panel (as marked)
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gauge.

• Options: These components are part of optional accessories. Dif-
ferent models have different options.

• Message Board: This text box logs changes in system modes and 
component states. It also logs errors and warnings that the program 
captures from the UGA. To retrieve a copy from file, open the log 
file from menu View > View Logs.

The program provides options to read and display various mea-
surements from the UGA. These measurements are grouped in the 
docking window as marked in Figure 2-14. 

		  2.3.4.3	    UGA Measurements

Fig. 2-14. UGA measurements docking window (as marked)
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		  2.3.4.4	    UGA Heater Settings

The UGA Measurements docking window presents the data in a ta-
ble and two time plots–one for pressures and one for temperatures. 
Check a checkbox next to a measurement in the table adds that data 
to the plot; unchecking the checkbox does the opposite. Time plots 
and table carry the similar features seen throughout the program 
with options to change attributes and export data. Access these op-
tions with the context menu (right-click on the widget to bring up 
the context menu). To change the display attributes of a curve line 
in the plot use the context menu on its legend. Plot settings are re-
tained in system registry and recalled when the program starts up.

Measurements are obtained from the UGA based on the options 
specified in the Preferences > Data > UGA > Data Logging (accessed 
via File menu). Enabling/disabling data reading can also be select-
ed from menu UGA > Read UGA Measurements. The same option 
is also available under the docking window’s menu (menu icon on 
top-right corner).

The plot toolbar (located on the top of the docking window) pro-
vides a few shortcuts for operations on the plots. The Sync Plots 
option allow settings in one plot applied to the other one.

Notes:
•  If an RGA scan is in progress, UGA measurements may not be avail-
able right away. This is more noticable in an Analog or a Histogram scan. 
The program reads UGA measurements when a scan finishes. Data points 
in time plots may appear further apart in this case. 

• An “N/C” (Not Connected) value means the measurement reading is 
invalid with a numerical value 255. On the temperature plot, these 255 
values still exist but are masked out in a full scale view.

For a system equipped with heaters, the user can control the tem-
perature for each heater individually. There are two sets of settings 
pertaining to the type of heating: System Bake and Sample Heaters.

• System Bake Settings: These settings allow you to customize 
baking temperatures and baking time used when initiating the sys-
tem bake function on menu UGA > Turn On System Bake. Select 
menu UGA > System Bake Settings to open the System Bake Set-
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tings dialog box (Fig. 2-15). The baking time can be from 2 to 100 
hours. Elbow and chamber temperatures can be set from 0 to 120 
°C. The lowest baking temperature is 40 °C. Setting 0 °C means the 
system will not turn on the heater. Each heater can be controlled 
separately.

Fig. 2-15. System bake settings dialog box

• Sample Heater Settings: A UGA system equipped with the Sam-
ple Heater Accessory (option O100HC) have two additional heat-
ers: the sample line heater and the capillary heater, in addition to 
the baking heaters – the elbow and chamber heaters. For heated 
gas sampling the capillary and the sample line of UGA need to be 
heated. In some cases the RGA chamber needs to be heated also. To 
control the temperature of sample heaters, open the Sample Heater 
Settings dialog box (Fig. 2-16) from menu UGA > Sample Heater 
Settings.

Fig. 2-16. Sample heater settings dialog box
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		  2.3.4.5     UGA Preferences

The 4 temperatures can be set individually. The default values are 
0 °C for Elbow and RGA chamber, and 80 °C for Sample line and 
Capillary. Setting 0 °C means the system will not turn on the heat-
er. Sample line and capillary temperatures can be set up to 100 °C. 
In a high temperature model UGA_HT, sample line and capillary 
temperatures can go up to 220 °C.

Options under Preferences provide default settings when the pro-
gram starts up. To access UGA preferences (Fig. 2-17), select menu 
File > Preferences. UGA specific settings include the following:

General > Layout

Plots > UGA

Data > UGA > Data Logging

• Show UGA measurements table: Enabling this option dis-
plays a table listing UGA pressure and temperature measure-
ments in the UGA docking window.

• Show Pressure Charts & Show Temperature Charts: Op-
tions under these groups specify what measurement is in-
cluded in the time plots. The plots are displayed in the UGA 
docking window.

• Data file location: Default location where the UGA data is 
saved.

• Read measurements from UGA: If enabled, the program 
automatically read UGA measurements when a UGA is con-
nected. The reading option can also be toggled manually from 
menu UGA > Reading UGA Measurements.

• Interval between reads: This parameter specifies the min-
imum interval in seconds between 2 consecutive readings. 
Note that if an RGA scan is in progress, the program must 
wait for the scan to finish before performing the next read-
ing of UGA measurements. The time interval between 2 data 
points may increase in this case.
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Data > UGA > Units

	

	

• Auto save text data: If enabled, UGA measurements are 
saved to a csv-formated text file under the specified file lo-
cation. The file name has the format UGA-SN<serial_num-
ber>-<timestamp>.txt where the timestamp is in format 
yyyyMMdd-hhmmss-fff (fff is in miliseconds). Data is ap-
pended to the text file whenever the program is instructed 
to read the measurements. This means that you can stop 
and restart reading the measurements, and data is written 
to the same file. A new file is created on a new connection 
to a UGA.

• Pressure unit: The unit used for all pressure measurements. 
Available units are: Torr, bar, mbar, Pascal and atm. The de-
fault unit is Torr.

Note: Temperature unit is always in Celcius.

Fig. 2-17. UGA plot and data preferences
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	 2.3.5	 Options and Sample Heater Accessory

		  2.3.5.1     Multiple Inlet Valve

In the UGA Status/Control panel, the Multiple Inlet shows the cur-
rent valve position next to the state LED icon. To change to a new 
inlet channel, click on the wrench icon and select the desired chan-
nel (Fig. 2-18). The valve will rotate to the new position. Before the 
valve is used, plug the unused channels with the provided plugs. A 
user can use any length of capillary as long as the allowed operat-
ing pressures are obtained. Please note, however, that the response 
time will be affected by the length of the capillary.

                  Fig. 2-18 - Multiple inlet valve control

Tip: The multiple inlet channel can be changed dynamically in a scan run 
without stopping it. Users can insert command “ZCMI <N>” in a scan 
sequence to instruct the software to change the inlet channel. Refer to the 
Hardware Control step of the RGA scan configuration for more informa-
tion.
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In the UGA Status/Control panel, click the wrench icon to control 
the vent valve (Fig. 2-19). Select “Close” or “Open” option. When 
“Open” is selected, the UGA will first open the valve for 1 second. 
Then it will wait for 40 seconds to open it again for a minute. After 
this, the valve will be closed. By doing this, the turbo pump will 
stop smoothly without a pressure shock. This function helps the 
system to stop safely in several minutes and to protect the RGA 
chamber from contamination.

                  Fig. 2-19 - Vent valve control

With the option 3 of UGA, a normal TP will be replaced with an 
upgraded TP, which is specialized for pumping low mass mole-
cules, like H2. The related parts will be assembled together at the 
factory. However, operational functionality is exactly same as that 
of a normal TP.

		  2.3.5.2     Vent Valve

	

		  2.3.5.3     Hydrogen Pumping Specified TP
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Select menu UGA > Sample Heater Settings. Type in the desired 
temperature settings in the Sample Heater Settings dialog box (Fig. 
2-16). The heating temperatures can be set from 40 °C to the maxi-
mum of 100 °C. This temperature limit is important for the valves’ 
(Sample valve & Bypass valve) performance. In a high temperature 
model UGA_HT, sample line and capillary temperatures can go up 
to 220 °C. The default values are 0 °C for Elbow and RGA chamber, 
and 80 °C for Sample line and Capillary.

After the heating temperatures are set, press “Sample heater on” 
from the front panel or select menu UGA > Turn On Sample Heaters 
on the software. This will heat up the capillary, the pinhole holder, 
and the sample line until right after the bypass valve.

		  2.3.5.4     Sample Heaters
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Chapter 3  

Remote Programming

In This Chapter This chapter discusses remote prgramming of the 
UGA. 
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3.1	 Introduction
	
	

	
	

	 3.1.1  Communication via RS-232

	

	

	 3.1.2  Communication via Ethernet

	 3.1.3  Command Format

The UGA may be controlled via either Ethernet interface or RS-232 
interface remotely.  See the chapter 2 of this manual for how to get 
connected.

The UGA uses a DB9 connector for serial communications.  The 
female DB9 connector on the UGA is configured as a DCE (transmit 
on pin 2, receive on pin 3) device and supports CTS/RTS hardware 
handshaking. The RTS signal (pins 8) is an output indicating that 
the UGA is ready, while the CTS signal (pin 7) is an input that is 
used to control the UGA’s data transmission. Ground is pin 5.  The 
UGA uses hardware handshaking, one stop bit, no parity , baud 
rate either 28800 or 38400.

A user may connect the UGA either directly to the host comput- 
er with a cross-over cable, or to a hub or switch with a straight- 
through CAT5 cable. To connect UGA to internet, you will need 
a static IP (Internet Protocol) address, Subnet Mask, and Gateway 
address. See your network administrator to obtain addresses ap- 
propriate for your network environment.

Communications with the UGA uses ASCII characters. Because the 
UGA is case insensitive, all commands may be in either UPPER or 
lower case. A command starts from a character after a termination 
character and ends with a termination character.  The UGA uses 
carriage return, <CR> as the termination character. 

The UGA has two separate sets of commands that are handled by 
separate microprocessors.  One is the UGA command set which is 
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processed by UGA main controller, and the other is the RGA com-
mand set which is processed by RGA controller. A command start-
ing with a ‘Z’ is handled by the UGA main controller, and a com-
mand starting with other characters is handled the RGA controller.  
A command in the UGA command set consists of a four character 
command mnemonic, arguments if necessary, and a command ter-
minator. The command, arguments and terminator may be sepa-
rated by spaces. No command processing occurs until a <CR> ter-
minator is received. 

Commands may require one or more parameters. Multiple param-
eters are separated by commas (,). 

The present value of a particular parameter may be determined by 
querying the UGA for its value. A query is formed by appending a 
question mark ’?’ to the command mnemonic and omitting the de-
sired parameter from the command. Values returned by the UGA 
are sent as a string of ASCII characters terminated by a carriage 
return <CR>. 

The four letter mnemonic (shown in CAPS) in each command se-
quence specifies the command. The rest of the sequence consists 
of parameters. Parameters shown in { } are not always required. 
Generally, parameters in { } are required to set a value in the UGA. 
Multiple parameters are separated by commas. The present value 
of a parameter may be determined by sending a query command.

• Commands that MAY be queried show a question mark in 		
    parentheses (?) after the mnemonic.
• Commands that are ONLY queries have a ’?’ after 
    the mnemonic, with no parentheses.
• Commands that MAY NOT be queried have no ’?’.

A query is formed by including the question mark ? after the com-
mand mnemonic and omitting the queried parameter from the 
command. The query parameters shown in { } are NOT sent with a 
query. The query returns the value of these parameters. Values are 
returned as a string of ASCII characters (unless otherwise noted). 

	

	
	

	 3.1.4  Command Syntax
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3.2 	 Commands

	 3.2.1  Mode setting commands

		  ZMST

Do NOT send ( ) or { } as part of the command. For example, the 
command sequence ZPTB(?) i {, j} is used as follows.

ZPTB1, 105  Set the bake temperature for the chamber heater (1) to 
105 oC. 

ZPTB? 1 Query the bake temperature for the chamber heater (1).
 
Variables are defined as follows.
i,  p 		  integers
i.i.i.i  	 	 Dotted decimal format for IP address, 
		  Subnet Mask, and default gateway address 
s 		  text string for login name and password 

Commands to set values which may be different for each channel 
require the p parameter.

These values must be queried separately for each channel.
All numeric variables should be expressed in integer (i.e., 5), nei-
ther floating point (5.0) nor exponential formats (0.5E1). Strings are 
sent as a sequence of ASCII characters.

Start
	 The ZMST command initiates START mode. It turns on all 		
	 the components according to the automated START 		
	 sequence, and brings the instruments to the READY state.

Example
ZMST		  begins START mode. 

Errors and warnings 
The command will be ignored if any of these conditions are true.
ZMST may cause these errors.
Warning 	 47 	 “Leak Test ON”
Warning 	 48 	 “System Bake ON”
Warning 	 51 	 “Pressure Check off”
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Stop
	 The ZMSP command initiates STOP mode. Turn off all the 		
	 components according to the automated STOP sequence.

Example
ZMSP		  begins STOP mode. 

Errors and warnings 
ZMSP should work in any condition.

Sleep
	 The ZMSL command initiates SLEEP mode. It puts the 		
	 UGA to IDLE state from READY state.  If the turbo 			
	 pump is off, the ZMSL command will fail with the warning 	
	 42.  
	
Example
ZMSL		  begins SLEEP mode. 

Errors and warnings 
The command is ignored if any of these conditions are true.
Warning 	 42 	 “Turbo not ready”
Warning 	 47 	 “Leak Test ON”
Warning 	 48 	 “System Bake ON”

Leak Test mode
	 The ZMLT i command turns the leak test mode Off (i=0) or 		
	 On (i=1).  The ZMLT? command returns whether the 	 	
	 leak test mode is On or Off. If the RGA is not On, 	 	 	
	 ZMLT will fail with the warning 44.  

Example
ZMLT 1	 starts the leak test. 
ZMLT?		 returns the status of the Leak test function,
	 	 On(1) or Off(0).

Errors and warnings 
The command is ignored if any of these conditions are true.
Warning 	 44 	 “RGA OFF”
Warning 	 48 	 “System Bake ON”

		  ZMSP

		  ZMSL

		  ZMLT (?) {i}
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		  ZMBK (?) {i}

		

		  ZMOD?	

	

System Bake mode
	 The ZMBK i command turns the system bake mode Off 	 	
	 (i=0) or On (i=1).  The ZMBK? command returns whether 	 	
	 the system bake mode is On or Off. 

Example
ZMBK 1	 starts the system bake. 
ZMBK?	 returns the state of the Bake mode, On(1) or Off(0).

Errors and warnings 
The command is ignored if any of these conditions are true.
Warning 	 47 	 “Leak Test ON”
Warning 	 51 	 “Pressure Check off”

System mode query
	 The ZMOD? Query returns the current UGA mode 
	 described below.

 Off 	 	 	 (1) 	 all components are OFF

 START		  (3)	 Automatic START sequence in prog		
				    ress
 STOP			   (4)	 Automatic STOP sequence in prog		
				    ress 

 READY 		  (6)	  RGA is on

 SLEEP 		  (7)	  Automatic SLEEP sequence in prog		
				    ress

 IDLE 			   (8) 	  TP and RP are idle, all other compo		
	 	 	 	 nents are off. 

LEAK TEST        	 (10)  	 Leak test mode is ON

SYSTEM BAKE 	 (12) 	 System Bake is ON

MANUAL   		  (13) 	 Manually changed of the state of a 		
	 	 	 	 component from a pre-defined state 
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Bypass pump Off/On
	 The ZCBP i command turns the bypass pump Off (i=0) or 	 	
	 On (i=1).  The ZCBP? query returns whether the 
	 bypass pump is Off (0), On (1), turning on (3 or 4), or 
	 turning off (6 or 7).

Example
ZCBP 1	 Turns the bypass pump On. 
ZCBP? 	 Returns the state of the bypass pump. 

Errors and warnings 
The command is ignored if any of these conditions are true.

ZCBP 0 :
Warning 	 33 	 “Bypass valve OPEN”

ZCBP 1 :
Warning 	 48 	 “System Bake On”
Error 		  96 	 “CM malfunction”
Error  		  98 	 “BP too high”

Roughing pump Off/On/Idle
	 The ZCRP i command turns the roughing pump Off (i=0), 	 	
	 On(i=1), or Idle(i=2). The ZCRP? query returns whether the 	
	 roughing pump is Off (0), On (1), Idle (2), turning on (3 or 	 	
	 4), turning off (6 or 7), or turning idle (8 or 9).

Example
ZCRP 1	 Turns the roughing pump On. 
ZCRP? 	 Returns the state of the roughing pump. 

Errors and warnings 
The command is ignored if any of these conditions are true.

ZCRP 0 :
Warning 	 41 	 “Turbo pump running”

ZCRP 1 :
Warning 	 33 	 “Bypass valve OPEN”
Warning	 34 	 “Sample valve OPEN”
Error  		  102 	 “RP too high”

	 3.2.2  Components control commands

		  ZCBP (?) {i}

		  ZCRP (?) {i} 	
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		  ZCTP (?) {i}

 	

ZCRP 2 :
Warning 	 33 	 “Bypass valve OPEN”
Warning	 34 	 “Sample valve OPEN”
Warning  	 38 	 “Rough pressure HIGH”

Turbo pump Off/On/Idle
	 The ZCTP i command turns the turbo pump Off (i=0), 	 	
	 On(i=1), or Idle(i=2). The ZCTP? query returns whether the 	
	 turbo pump is Off (0), On (1), Idle (2), turning on (3, 4 or 	 	
	 5), turning off (6 or  7), or turning idle (8,  9 or 10), or 	 	
	 in Error state (12).

Example
ZCTP 1	 Turns the turbo pump On. 
ZCTP? 	 Returns the state of the turbo pump. 

Errors and warnings 
The command is ignored if any of these conditions are true.

ZCTP 0 :
Warning 	 43 	 “RGA ON”
Warning 	 46 	 “IG ON”
Warning 	 48 	 “System Bake ON”
Error  		  110 	 “TP stop failed” 

With Error 110, the ZCTP? query returns Error state (12), until the 
turbo pump is turned off.

ZCTP 1 : 
Warning 	 36 	 “Roughing pump OFF”
Error  		  104 	 “TP too high”
Error 		  111 – 120 	 Error conditions detected by the 
		  turbo pump controller. Once one of these errors 
	 	 occurs, the UGA has to be turned off and turned on 	
		  again to clear the error.
ZCTP 2 :
Warning 	 36 	 “Roughing pump OFF”
Warning 	 48 	 “System Bake ON”
Error  		  104 	 “TP too high”
Error 		  111 – 120 	 Error conditions detected by the 
		  turbo pump controller. Once one of these errors 
		  occurs, the UGA has to be turned of and turned on 
		  again to clear the error.

With Error 104, the ZCTP? query returns Error state (12), until the 
turbo pump turns off.
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Bypass valve Off/On
	 The ZCBV i command turns the bypass valve Closed (i=0) 	 	
	 or Open (i=1).  The ZCBV? query returns whether 	 	 	
	 the bypass valve is Closed (0), Open (1), turning open (3 or 	
	 4),  turning closed (6 or 7).

Example
ZCBV 1	 Opens the bypass valve. 
ZCBV? 	 Returns the state of the bypass valve. 

Errors and warnings 
The command is ignored if any of these conditions are true.

ZCBV 0 :
Warning 	 34 	 “Sample valve OPEN”

ZCBV 1 :
Warning 	 48 	 “System Bake On”
Warning 	 30 	 “Bypass pump OFF”
Error  		  99 	 “BV too high”

Sample valve Off/On
	 The Sample valve operates differently depending on the 
	 automatic sample valve states (associated with ZPAS 		
	 command). 
(1)    With the automatic  sample valve Off, 
	 The ZCSV i command turn only the sample valve Closed 		
	 (i=0) or Open (i=1).
(2)    With the automatic sample valve On, 
	 The sample valve, the bypass valve, and the bypass pump 		
	 work as a unit. The ZCSV 1 command turns the bypass 		
	 pump on, opens the bypass valve, and then opens 			 
	 sample valve. The ZCSV 0 command closes 				 
	 the sample valve, closes the bypass valve, and turn 			
	 off the bypass pump. 

Example
ZCSV 1	 Opens the sample valve. 
ZCSV? 	 Returns the state of the sample valve. 

Errors and warnings 
The command is ignored if any of these conditions are true.

		  ZCBV (?) {i}

		  ZCSV (?) {i} 
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		  ZCRG (?) {i}

		  ZCIG (?) {i} 	

ZCSV 1 :
Warning 	 32 	 “Bypass valve CLOSED”, when  ZPAS is off
Warning 	 48 	 “System Bake On”
Error		  100	 “SV too high”

RGA Off/On
	 The ZCRG i command turns the RGA Off (i=0) or On (i=1). 
	 The ZCRG? query returns whether the RGA is Off (0), On 	 	
	 (1), in the leak test mode (2), turning on (3 or 4), turning off 	
	 (6 or 7), or going into the leak test mode (8 or 9).

Example
ZCRG 1	 Turns the RGA On. 
ZCRG? 	 Returns the state of the RGA. 

Errors and warnings 
The command is ignored if any of these conditions are true.

ZCRG 0 :
Warning 	 47 	 “Leak Test On”
Error 	 	 80 	 “RGA off failed”

ZCRG 1 :
Warning 	 42 	 “Turbo not ready”
Warning 	 47 	 “Leak Test On”
Warning 	 48 	 “System Bake On”

Ion gauge Off/On/Degas
	 The ZCIG i command change the ion gauge state to Off 	 	
	 (i=0), On (i=1), or Degas (i=2).  The ZCIG? query returns 	 	
	 the current ion gauge state.

Examples
ZCIG 2      	 Degasses the ion gauge for 3 minutes and returns 
		  the gauge state to the previous state, depending 
	 	 on it was on or off.

Errors and Warnings
The command is ignored if any of these conditions are met.

Error 		  73	 “No IG detected”
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ZCIG 0
Error 	 	 78 	 “IG off failed”

ZCIG 1
Warning   	 42	 “Turbo not ready”
Error       	 74	 “IG unexpected off”
Error       	 76	 “IG voltage”
Error       	 77	 “IG emission”
Error     	 105	 “IG too high”

ZCIG 2
Warning   	 42	 “Turbo not ready”

Vent valve Off/On
	 The ZCVV i command turns the vent valve Off (i=0), or On 	
	 (i=1).  The ZCVV? query returns the current vent valve state.

ZCVV 1 command opens the vent valve for 1 second, closes it for 
the next 40 seconds, opens again for the next 60 seconds, and finally 
closes it. This command goes in the cycles not to vent the chamber 
too fast while the turbo pump is running in full speed. 
ZCVV? returns 1 through the whole cycles. and return 0 after the 
final closure. 

Errors and Warnings
The command is ignored if any of these conditions are met.

ZCVV 1
Warning 	 37	 “Roughing pump ON”
Error      	 85	 “No Vent valve”

Pressure interlock Off/On
	 The ZCPC i command sets Pressure Interlock state to Off 	 	
	 (i=0), or On (i=1).  The ZCPC? query returns the 
	 current value of Pressure Interlock state.

If the state is 1, UGA keeps monitoring pressures from PG, CM, and 
IG to protect itself from any pressure changes.  If 0, it disables pro-
tection based on PG, IG and CM readings. It should be used only by 
very advanced users or for trouble shooting.

`

		  ZCVV (?) {i}

		  ZCPC (?) {i} 
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		  ZCHT (?) {i}

		  ZCMI (?) {i}

Errors and Warnings
The command is ignored if any of these conditions are met.

ZCPC 1
Warning 	 48	 “System Bake ON”
Warning 	 49	 “AUTO sequence ON”

Heaters Off/Bake Heaters On/Sample Heaters On
	 The ZCHT i command turns heaters Off (i=0), the bake 	 	
	 heater(s) On (i=1), or the sample heater(s) On(i=2).   		 	
	 The ZCHT? query return the current heater state.

If the mode is 1, the heater temperature is controlled to the 			
bake temperatures set by ZPTB command.
If the mode is 2, the heater temperature is controlled to the 			
sample heat temperatures set by ZPTH command.

Errors and Warnings
The command is ignored if any of these conditions are met

Error 		  61	 “Heater initialize”

ZCHT 0
Warning 	 48 	 “System Bake ON”

ZCHT 1
Warning 	 42 	 “Turbo not ready”
Error 		  62 	 “Elbow Heater T/C”

Multiple inlet channel
	 The ZCMI i command changes the multiple inlet valve 
	 channel to i. The valid values for the channel number are 		
	 from 1 to 16.  The ZCMI? query returns the current 			
	 channel number if it is installed. If not, it returns 0. If 		
	 the channel number reported from the multiple 
	 inlet valve controller is different from the channel number 		
	 set by the main controller, it returns 17.

Example
ZCMI 12	 Changes the channel number to 12
ZCMI?		 Returns the current channel number, as well as 0 
		  or 17 if it has an error condition.



Phone: (408)744-9040
www.thinkSRS.com

UGA Series Universal Gas Analyzers

Remote Programming 3 – 14

Errors and warnings
The command is ignored if any of these conditions are true.

Error 		  81	 “No Mux detected”

Speaker volume 
	 The ZCVL i command set the speaker volume to Off (i=0), 	 	
	 Low (i=1), Medium (i=2), or High (i=3).  The ZCVL? 	 	
	 query returns the current speaker volume.

Example
ZCVL 1    	 Sets the speaker volume to Low.

Component states
	 The ZBST? query returns the component current state bits.  	
	 It returns an integer that contains the following bit 
	  information. 

Bit Name			   Bit Number	 Bit set on
STATE_BIT_ERROR     	 BIT15		  Any error condition
STATE_BIT_POWER     	 BIT14		  Power up
STATE_BIT_AUTO      	 BIT13		  Automatic mode is 		
						      entered
Reserved			   BIT12		  Reserved
STATE_BIT_BAKE    	   	 BIT11		  Bake mode is entered
STATE_BIT_HEAT      	 BIT10		  A heater is active
STATE_BIT_VENT      	 BIT9		  The vent valve open
STATE_BIT_IG        		  BIT8		  IG active
STATE_BIT_RGA       		 BIT7		  RGA active
STATE_BIT_SV        		  BIT6		  SV open
STATE_BIT_BV        		  BIT5		  BV open
STATE_BIT_TPIDLE    	 BIT4		  TP goes idle
STATE_BIT_TP        		  BIT3		  TP is on
STATE_BIT_RPIDLE    	 BIT2		  RP goes idle
STATE_BIT_RP        		  BIT1		  RP is on
STATE_BIT_BP        		  BIT0		  BP is on

		  ZCVL (?) {i}

	 3.2.3  State Query commands

 		  ZBST?

		



Stanford Research Systems
UGA Series Universal Gas Analyzers

Remote Programming3 – 15

		  ZBCT?

		  ZBTT? 

	 3.2.4  Query commands

		  ZQID? 

		  ZQFV?	

		  ZQSN?

Components changed
	 The ZBCT? query returns the component change state bits.  	
	 This returns only the bits (defined above in the ZBST 
	 command) that have changed  either from Off to On or 	 	
	 from On to Off and also either from Closed to Open or
	 from Open to Closed, since the ZBCT query was last issued.

Components in transition
	 The ZBTT? query returns the component transition bits. If 		
	 a bit is set, it indicates the corresponding component is in 
	 transition either from Off to On, or from On to Off and also 
	 either from Closed to Open or from Open to Closed. Once 
	 the transition is over, the bit value returns to zero.
	

Identification
	 The ZQID? query returns UGA ID string, the serial 
	 number, and the firmware version.

Example
ZQID?   	 If the command returns “SRS_UGA,
		  S/N:91000,V.1.000”, it means the unit is a UGA, 
	 	 the serial number is 91000, and the firmware 
		  version is 1.000.

Firmware version
	 The ZQFN? query returns the firmware version of the unit.

Example
ZQFV?  	 Returns the firmware version (e.g., 1.000).

Serial number
 	 The ZQSN? query returns the serial number of the unit.

Example
ZQSN?  	 Returns the firmware version (e.g., 91000).
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MAC address
	 The ZQMC? query returns the Ethernet media access 
	 control (MAC) address of the unit. The numbers are 6 		
	 bytes in the hexadecimal format.

Example
ZQMC?   	 Returns the MAC address 

Pressures
	 The ZQAD? i query returns a pressure reading 
	 corresponding to the following index. 	

	 Index 0: Pirani gauge reading in μTorr
	 Index 1: N/A
	 Index 2: CM gauge  reading in μTorr
	 Index 3: IG reading in pTorr 

 	 If the corresponding gauge is not on, the reading is 
	 meaningless.

Example
ZQAD? 0  	 If the command returns 100000, it means the Pirani 
		  gauge reading is 0.1 Torr.

ZQAD? 3 	 If the command returns 100000, it means the ion 
		  gauge  reading is 1.0E-7 Torr.

Turbo pump speed
	 The ZQHZ? query returns TP speed in revolutions per 
	 second.

Turbo pump current
	 The ZQCU? query retuns TP current in mA.

Turbo pump temperature
	 The ZQTT? query returns TP Temperature in degrees 
	 Celcius.

		  ZQMC?

		  ZQAD? i 	

		  ZQHZ?		

		  ZQCU?

		  ZQTT?
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 		  ZQTA?

		  ZQTB?

		  ZQTC? 

		  ZQTD? 

		  ZQBR?

	 3.2.5  Error query commands

		  ZERR?  

		  ZEDS? i

Elbow temperature
	 The ZQTA? query returns the elbow temperature in 
	 degrees Celcius.

Chamber temperature
	 The ZQTB? query returns the chamber temperature in 
	 degrees Celcius

Sample inlet temperature
	 The ZQTC? query returns the sample inlet temperature in 		
	 degrees Celcius.

Capillary temperature
	 The ZQTD? query returns the capillary temperature in 
	 degrees Celcius.

Remaining bake time
	 The ZQBR? query returns baking time remaining in 
	 minutes.

Error query
	 The ZERR? queries Error code. Whenever ZBST? Bit 15 is 		
	 set, use “ZERR?” to read errors.

Latest Errors up to 10 will be stored into the error stack. If there are 
more than 10 errors occur, the last error will replaced with TOO_
MANY_ERRORS (126). “ZERR?” returns the latest error first. To 
clear ZBST bit 15, you must issue ZERR? until you get 0. For the 
complete error list, refer to the Chapter 4 of this manual.

Error message
	 The ZEDS? i queries the error message corresponding to 		
	 an error number (9 to 126) returned with ZERR?.  This 
	 query returns a verbose string corresponding to the given 		
	 error code.
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	 3.2.6  Parameter setting commands
	

		  ZPBO (?) {i}	

		  ZPRO (?) {i}	

		  ZPRI (?)  {i}	
	

		  ZPBA (?) {i}	

Parameters changed with the following commands are saved in 
EEPROM, preserved even after power off, and loaded into system 
when UGA start again next time.  

Bypass pump on power  
	 The ZPBO i command sets the bypass pump on-power 
	 to a value from 30 % (i=30) to 100 % (i=100).  	 	
	 The ZPBO? query returns the current on-power 
	 setting for the bypass pump.

The parameter change is immediately effective all the time, even 
the bypass pump is running. The default setting is 60 % (i=60).

Roughing pump on power
	 The ZPRO i command sets the roughing pump on-power 
	 to a value from 30 % (i=30) to 100 % (i=100).  	 	
	 The ZPRO? query returns the current on-power 
	 setting for the roughing pump.

The parameter change is immediately effective all the time, even 
the roughing pump is running. The default setting is 60 % (i=60).

Roughing pump idle-power
	 The ZPRI i command sets the roughing pump idle-power 
	 to a value from 30 % (i=30) to 100 % (i=100).  	 	
	 The ZPRI? query returns the current idle-power 
	 setting for the roughing pump.

The parameter change is immediately effective all the time, even 
the roughing pump is idle. The default setting is 45 % (i=45)

RS232 baud rate
	 The ZPBA i command sets the RS232 baud rate to 		
	 28800 (i=0), or 38400 (i=1).  The ZPBA? query 
	 returns the current RS232 baud rate setting.

The parameter change is immediately effective all the time. This 
means if it is changed, the current serial communication will stop.
Users should be careful to change this parameter when they are us-
ing the serial communication.
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	 ZPIP (?) {i.i.i.i} 

	 ZPSM (?) {i.i.i.i} 

	 ZPGW (?) {i.i.i.i}

IP address
	 The ZPIP i.i.i.i command sets the Internet Protocol (IP) 
	 address of the instrument.   The ZPIP? query returns the 	
	 current IP address setting.

The parameter change is immediately effective all the time. This 
means if it is changed, the current Ethernet communication will 
stop. Users should be careful to change this parameter when they 
are using the Ethernet communication.

Example
ZPIP 192.168.1.12       Sets the IP address to 192.168.1.12.

Errors and Warnings
The command is ignored if the following error is issued after the 
command input.

ZPIP i.i.i.i 
Warning 	 16 	 “Bad parameter”

IP Subnet Mask
	 The ZPSM i.i.i.i command sets the Internet Protocol (IP) 	
	 Subnet Mask of the instrument.  The ZPSM? query returns 	
	 the current IP Subnet Mask setting.

Example
ZPSM 255.255.255.0      Sets the IP Subnet Mask to 255.255.255.0.

Errors and Warnings
The command is ignored if the following error is issued after the 
command input.

ZPSM i.i.i.i 
Warning 	 16 	 “Bad parameter”

IP default Gateway 	
	 The ZPGW i.i.i.i command sets the Internet Protocol (IP) 
	 default Gateway of the instrument.  The ZPGW? query 
	 returns the current IP default Gateway setting.

Example
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		  ZPNM (?) {@s} 	

 

		  ZPPW (?)  {@s}

ZPGW 192.168.1.1       Sets the IP default Gateway to 192.168.1.1.

Errors and Warnings
The command is ignored if the following error is issued after the 
command input.

ZPGW i.i.i.i 
Warning 	 16 	 “Bad parameter”
	

TCP/IP login name
	 The ZPNM @ABC command sets the login name of the 	
	 instrument to ABC for the TCP/IP connection.  The 		
	 ZPNM? query returns the current login name.

The command accepts only alphanumeric characters, a-z, A-Z, 
and 0-9. The login name should be 15 characters or less. The de-
fault is “SRSUGA”.

Examples
ZPNM @SRSUGA 	 Sets the login name to SRSUGA

ZPNM @  		  Clears the login name. 
With blank login name and password, a user can login to the 
instrument by typing carriage returns only.

Errors and Warnings
The command is ignored if the following error is issued after the 
command input.

ZPNM @s%? 
Warning 	 16 	 “Bad parameter”

TCP/IP password
	 The ZPPW @ABC command sets the password of the 
	 instrument to ABC for the TCP/IP connection.  The 		
	 ZPPW? query returns the current password.

The command accepts only alphanumeric characters, a-z, A-Z, 
and 0-9. The password should be 15 characters or less. The de-
fault is “SRSUGA”.
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		  ZPDU (?) {i}	
	

		  ZPSP (?) {i}	

		  ZPTO (?) {i}	

		  ZPFL (?) {i}  	

Examples
ZPPW @SRSUGA 	 Sets the password to SRSUGA

ZPPW @  		  Clears the password. 
With blank login name and password, a user can log into the instru-
ment by typing carriage returns only.

Errors and Warnings
The command is ignored if the following error is issued after the 
command input.

ZPPW @s3# 
Warning 	 16 	 “Bad parameter”

Ethernet Half Duplex/Full Duplex
	 The ZPDU i command sets the Ethernet half duplex (i=0) or 	
	 full duplex  (i=1). The default value is full duplex.  The 	 	
	 ZPDU? queries whether the Ethernet is full duplex, or half 		
	 duplex. 

Ethernet Speed Auto/10 Mbps/100 Mbps
	 The ZPSP i command sets Ethernet speed Auto-
	 negotiation (i=0), 10 Mbps (i=1), or 100 Mbps (i=2). The 
	 default value is 100 Mbps.

TCP/IP connection timeout
	 The ZPTO i command sets the TCP/IP connection timeout 		
	 between 3 to 1800 seconds.  The ZPTO? query returns the 		
	 value.   If TCP/IP communication is inactive for the 			
	 timeout period, the connection will be closed.  The default 		
	 value is 2 minutes.  The power reset is needed to activate
	 the changed value.

Ion gauge filament
	 The ZPFL i command selects either of the filament 1 (i=0), 
	 or the filament2 (i=1), which is used when the ions gauge 
	 turns on or degasses. The ZPFL? returns the selected 
	 filament (0 or 1).
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		  ZPPU (?) {i} 	

		  ZPAV (?) {i} 

		  ZPAS (?) {i} 	

		  ZPLM (?) {i} 

Pressure unit
	 The ZPPU i command sets the pressure unit used for the 
	 front panel display: Torr(i=0), Pa(i=1), mbar(i=2), or bar(i=3).
	 The ZPPU? query returns the current pressure unit for the 	
	 display. This unit selection has NO effect on the unit used 	
	 by the ZQAD command.

Automatic vent valve
	 The ZPAV i command turns the automatic vent valve 
	 option  Off (i=0) or On (i=1).  The ZPAV? query returns 
	 the current value of the option. 

If this option is on, the vent valve will be opened at the end of 
the automatic STOP sequence, right after the roughing pump is 
stopped. If not, the STOP sequence ends without opening the vent 
valve.

Automatic sample valve 
	 The ZPAS i command changes the automatic sample 
	 valve option to Off (i=0), or On (i=1). The ZPAS ? query 
	 returns the current value of the option.

If a user opens the sample valve with this option on, the UGA turns
on the bypass pump, and opens the bypass valve, before opens the
sample valve automatically. If the user closes the sample valve 
with this option on, the UGA closes the sample valve and bypass 
valve sequentially, and turns off the bypass pump.

If the option off, the user can open the sample valve only when the
bypass valve is open, otherwise it will generate a warning.

Leak test mass
	 The ZPLM command sets and queries the mass that is 
	 monitored in the leak test mode. The mass can be between 
	 1 and 100 AMU. 

Example
ZPLM 44	 Sets the mass used for the leak test to 44 AMU.
ZPLM? 	 Returns the mass used for the leak test. 
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System bake time
	 The ZPBT command sets and queries the system bake time 	
	 in hours. It can be set between 2 and 100 hours. The system 	
	 bake mode will be on for this system bake time, and then 
	 will be turned off.

When the system bake mode is on, the time remaining can be que-
ried with the ZQBR? command.

Example
ZPBT 10	 Sets the system bake mode to 10 hours.
ZPBT? 		 Returns the system bake time. 

Bake temperature 
	 The ZPTB command sets the bake temperature of a heater 		
	 when Bake mode is on. The parameter p selects the elbow 		
	 heater (0), or the chamber heater (1). The parameter 		
	 i is a set temperature in Celsius for the heater p, and ranges 	
	 from 0 to 120. The default value for the parameter i is 105.    

If a set value for a heater is 0, the heater stays off during the bake 
mode, and it is not tested for its faulty conditions.

Example
ZPTB 1, 105	 Sets the bake mode set temperature of the chamber 		
		  heater to 105 °C.
ZPTB? 1	 Returns the bake mode set temperature of the 
		  chamber heater. 

Errors and Warnings
The command is ignored if this condition is met.

Error 		  66 	 “Temp. Set Failed”

Sample temperature
	 The ZPTH command sets the Sample temperature of
	 a heater when the sample mode is on. The parameter p
	 selects the elbow heater (0), the chamber heater (1),
	 the sample line heater (2), or the capillary heater (3). The
	 parameter i is a set temperature in Celsius for the heater p.

	 ZPBT (?) {i}
	

	 ZPTB (?) p {,i}

	

	 ZPTH (?) p {,i} 
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		  ZPDF	  	

For for the elbow heater and the chamber heater, range is from 0 to
120, and the default value is 105. For sample line heater and capil-
lary heater the range is from 0 to 100, and the default value is 80. If
a set value for a heater is 0, the heater stays off during the sample
mode, and it is not tested for its faulty conditions.

Example
ZPTH 2, 80	 Sets the sample mode set temperature of the 
		  sample line heater to 80 °C.
ZPTH? 2	 Returns the sample mode set temperature of 
		  the sample line heater. 

Errors and Warnings
The command is ignored if this condition is met.

Error 		  66 	 “Temp. Set Failed”

Factory default
	 The ZPDF command resets all the parameter saved 	in
	 EEPROM to the factory default values. 

It is useful to set the UGA to the known initial state, when the user
experiences problems due to corrupted parameters. After loading 
Factory default values, the user has to re-enter all the network pa- 
rameters (IP address, Subnet Mask, and default Gateway) to access
to Ethernet interface again.
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Chapter 4
  

UGA Error Messages

In This Chapter This chapter lists and explains all the error messag-
es displayed on the UGA.

4.1	 Introduction   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  	 4–2
4.2	 Error messages   .  .  .  .  .  .  .  .  .  .  .  .  .  .                	 4–3
		  Communication errors messages   .  .    	 4–3
		  Warning error messages   .  .  .  .  .  .  .         	 4–5
		  Critical error messages  .  .  .  .  .  .  .  .          	 4–8
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4.1      Introduction
The UGA reports various errors as they are detected. When an error 
is detected, a message is shown on the front panel display and the 
error is logged for retrieval over the remote interface.  Users must 
also check for RGA head errors. The RGA has its own microproces-
sor and its own error reporting commands.  The RGA error status 
is monitored with the error query command, ER? For details, refer 
to RGA manual chapters 7 and 9.

UGA error messages are divided into three groups: communication 
errors, warning errors, and critical errors.

Communication errors are those related to miscommunication with 
a host computer.  When a communication error is detected, UGA 
flashes the warning LED once without changing display. It stores 
the error number corresponding to the error into the error stack. 
The error numbers for communication errors range from 9 to 29.
   
Warnings are issued when UGA is not able to carry out a command 
sent over the remote interface or a menu selection chosen from the 
front panel. With a warning, the warning LED flashes for 4 seconds, 
a warning sound beeps, and the warning message is displayed. Af-
ter several seconds, the warning is no longer shown, and the dis-
play returns to the previously active display. The range of the warn-
ings is from 30 to 60.

Critical errors are issued when the UGA detects problems while 
monitoring various internal conditions, or trying to carry out a 
command or a menu selection. The front panel displays the er-
ror message with error beeps, until a button on the front panel is 
pressed, or all the errors in the error stack are read up by sending 
“ZERR?” commands until it returns 0. The range of the critical er-
rors is from 61 to 120. 

ZERR? Returns only an error code.  To get a string describing the 
error code, use the ZEDS? [error number] Query.  For example, 
“ZEDS? 42” returns “Turbo not ready”.

Following is the list of errors that UGA reports. The first column 
shows the error code, and the second column shows error messages 
showing on the display, followed by a description of each error. 
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  1 – 8	 Reserved    

  9	 “Invalid Command”,      
	 The command string does not start with a valid command 		
	 name. 
 
 10    	 “Incomplete Command”,   
 	 The command string ends without a ? or a parameter.

 11	 “Illegal Command”,      
	 Either a set only command was issued as a query or a 
	 query only command was issued as a set.

 12 	 Reserved 

 13	 “Missing Parameter”,           
	 A second parameter in a set command is missing.
   
 14 	 “Extra Parameter”,            
	 Extra character(s) follow a valid command.

 15	 “Out of range”,                
	 A parameter is out of range

 16 	 “Bad parameter”,               
	 A parameter is misformatted, such as an IP address, 
	 a Subnet Mask, a Gateway address, a login name, 
	 or a password. 

 17 	 “Missing comma”,               
 	 Command string does not have a comma after the first 
	 parameter.

 18–19	 Reserved                 

 20 	 “Not a number”,                
 	 A Parameter is not a number.

 21 	 Reserved
 

4.2	 Error Messages

	 4.2.1  Communication Error Messages
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 22 	 “RGA on network”,              
	 When TCP/IP connection is open, the serial 
	 communication cannot talk to RGA.

 23 	 “Command buffer full”,         
	 The UGA received too many commands to process before 		
	 time critical operations occur. Some of the commands are 		
	 rejected.  

 24 	 “RGA buffer full”,             
	 The RGA received too many commands to process in time. 		
	 Some of the commands are rejected. 
 

 25 	 “RGA unavailable”,             
	 RGA is not available to communicate when transitioning 		
	 between power on and off, or transitioning into and 		
	 out of leak test mode.

 26	 “String too long”,          
	 The login name and password should be 15 characters or 		
	 less.

 27 	 “Illegal character”,       
	 The login name and password changing commands, 		
	 ZPNM and ZPPW accept alphanumeric characters 			 
	 0-9, A-Z, a-z only.

 28 	 “RGA OFF”,                  
	 Communication to RGA is not allowed when the RGA is 		
	 off.

 29 	 “Leak Test ON”,         
	 Communication to RGA is not allowed when the leak test 		
	 is running.
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30 	 “Bypass pump OFF”,      
	 The bypass valve is not allowed to open, when the 
	 roughing pump is not off (i.e. on or idle) and the bypass 		
	 pump is off.

 31 	 Reserved       

 32 	 “Bypass valve CLOSED”,  
	 The sample valve is not allowed to open, when the 
	 roughing pump is not off and the bypass valve is CLOSED.

 33 	 “Bypass valve OPEN”,    
	 (1) The bypass pump is not allowed to turn off, when the 
	       roughing pump is not off and the bypass valve is open.
	 (2) The roughing pump is not allowed to turn on or idle, 
	        when the bypass pump is not on and the bypass valve 
	        is open. 
	
 34 	 “Sample valve OPEN”,    
	 (1) The bypass valve is not allowed to CLOSE, when the 
	 roughing pump is not off and the sample valve is open.
	 (2) The roughing pump is not allowed to turn on or idle, 
	       when the bypass pump is not on and the sample valve 
	       is open. 

 35 	 Reserved 

 36 	 “Roughing pump OFF”,    
	 The turbo pump is not allowed to turn on or idle, when the 	
	 roughing pump is not on, or idle.

 37 	 “Roughing pump ON”,     
	 The vent valve is not allowed to turn on, when the 
	 roughing pump is on.

 38 	 “Rough pressure HIGH”,  
	 The roughing pump is not allowed to turn idle, when 
	 the roughing pressure is higher than 2 Torr.
 
 39 – 40 Reserved	

	 4.2.2  Warning Error Messages
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 41 	 “Turbo pump running”,   
	 The roughing pump is not allowed to turn off, when the 		
	 turbo pump is not off.

 42 	 “Turbo not ready”,      
	 The RGA, the ion gauge, or the bake heater is not allowed 
	 to turn on, when the turbo pump is not on nor idle.

 43 	 “RGA ON”,               
 	 The turbo pump is not allowed to turn off, when the RGA
	  is on.

 44 	 “RGA OFF”,              
	 The leak test mode is not allowed to start, when the RGA
	  is off.

 45	 Reserved             

 46 	 “IG ON”,                    
	 The turbo pump is not allowed to turn off, when the ion 		
	 gauge is on.

 47 	 “Leak Test ON”,             
	 When the leak test is running, the following actions are not 	
	 allowed:
	 (1) Start and sleep automatic sequences are not allowed to 		
	       start.
	 (2) The system bake is not allowed to start.
	 (3) The RGA is not allowed to turn off.

 48 	 “System Bake ON”,         
	 When the system bake is on, the following actions are not 		
	 allowed:
	 (1) Start and sleep automatic sequences are not allowed to 		
	       start.
	 (2) The leak test is not allowed to start.
	 (3) The bypass pump, bypass valve, and sample valve are 		
	       not allowed to open.
	 (4) The turbo pump is not allowed to turn idle or off.
	 (5) The RGA is not allowed to turn on.
	 (6) The heater is not allowed to turn off.
	 (7) Pressure Interlock Option may not be disabled
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 49 	 “AUTO sequence ON”,     
	 Pressure Interlock Option is not allowed to change during 		
	 one of the automatic sequences: start, sleep, and stop.
   
 
 50 	 “Interlock triggered”,  
	 The user interlock on the back panel is triggered to stop 		
	 the system.

 51 	 “Pressure Interlock off”,   
	 START sequence and the system bake are not allowed to 		
	 initiate with Pressure Interlock off.

 52 	 “Leak test timeout”,        
	 Communication time-out occurred during Leak Test. It 		
	 may happen once in a while. If it happens every 10 second 		
	 or so, the communication between the main control 		
	 board and the RGA is down. If so, turn RGA off and 		
	 on again to recover.

 53 	 “Fac. Default Loaded”,       
	 (1) With turning UGA on with the STOP button pressed, 		
	       Factory default setting is loaded instead of the saved 		
	       parameter setting. It is used to reset the instrument 		
	       to a known setting.
	 (2) Factory default setting is loaded during the power up 		
	      due to EEPROM setting corruption.

 54 - 60	Reserved    
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61 	 “Heater initialize”,        
	 Heater temperature settings are not initialized in time, 
	 probably due to miscommunication between the main 
	 control board and the auxiliary control board.

 62 	 “Elbow Heater T/C”,         
	 The thermocouple sensor attached on the elbow is an open 		
	 circuit.  The temperature cannot be read.

 63 	 “Chamber Heater T/C”,   
	 The thermocouple sensor attached on the main chamber is 		
	 an open circuit.  The temperature cannot be read.

 64 	 “Sample Heater T/C”,    
	 The thermocouple sensor attached on the sample line is an 		
	 open circuit.  The temperature cannot be read.

 65 	 “Capillary Heater T/C”,     
	 The thermocouple sensor attached on the capillary is an 		
	 open circuit.  The temperature cannot be read.

 66	 “Temp. Set Failed”,     
	 Temperature setting was not updated in time probably due 	
	 to miscommunication between the main control board and 	
	 the auxiliary control board.

 67	 “No Sample Heater”
	 Both thermocouple sensors on the sample line and the 
	 capillary are open. 

 68 – 72 Reserved

 73 	 “No IG detected”,         
	 The ion gauge control board is not detected.

 74 	 “IG unexpected off”,    
	 The ion gauge was turned off without reporting an error to 
	 the UGA.

	 4.2.3  Critical Error messages
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 75 	 Reserved

 76 	 “IG voltage”,           
	 (1) No power on the ion gauge controller board.
	 (2) The selected IG filament is burnt.
	 (3) The ion gauge failed to maintain the grid voltage. This 
	 condition turns off the ion gauge.
	
 77 	 “IG emission”,          
	 The ion gauge failed to maintain the emission current. This 	
	 condition turns off the ion gauge.

 78 	 “IG off failed”,            
	 The ion gauge is not turned off in time, probably due to 		
	 miscommunication between the main control board 		
	 and the auxiliary control board.

 79 	 Reserved
  
 80 	 “RGA off failed”,         
	 The RGA is not turned off in time, probably due to 
	 miscommunication between the main control board and 		
	 the auxiliary control board.

 81 	 “No Mux detected”,      
	 Multi-inlet valve controller is not detected.

 82 	 “Mux malfunction”,      
	 The multi-inlet valve channel reported from the controller 		
	 does not match with that of the main control board, 
	 probably due to miscommunication between the main 
	 control board and the auxiliary control board.

 83 - 84	Reserved

 85 	 “No Vent valve”,        
	 No vent valve was detected.

 86 – 88 Reserved 
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 89 	 “AUX comm. error”,      
	 Communication between the main control board and the 		
	 auxiliary control board did not work properly at least for a 	
	 second. 

 90 	 “Main board reset”,     
	 When the main control board powers up, the auxiliary 
	 control board reports that the turbo pump is on. It 
	 indicates the main control board is reset, while the 
	 auxiliary control board is on.

 91 	 Reserved

 92 	 “No PG detected “,         
	 Pirani gauge is not detected.

 93 	 “No PG filament”,       
	 The detected current through the Pirani gauge is too small; 	
	 this probably means the PG filament is damaged.
 

 94 	 “PG short-circuited”,   
	 Too much current flows through the Pirani gauge.

 95 	 “PG malfunction”,       
	 The roughing line pressure reading of the Pirani Gauge is 		
	 lower than 10 mTorr or higher than 1100 Torr for 10 		
	 seconds. This condition initiates the STOP sequence.

 96 	 “CM malfunction”,         
	 The sample line pressure reading from the capacitance 
	 manometer is lower than 10 mTorr for 10 seconds. It 
	 indicates the capacitance manometer is disconnected, or 
	 not working properly. This condition closes the sample 		
	 valve and the bypass valve, and turns off the bypass 		
	 pump. 

 97 	 Reserved
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 98 	 “BP too high”,          
	 (1) The sample line pressure did not reach 1.5 Torr in 2 
	     minutes with the sample valve closed.
	 (2) The sample line pressure did not reach 5 Torr in 2 
	       minutes when the sample line was pumping without
	       TP on.

 99 	 “BV too high”,          
	 The sample line pressure did not reach 1.5 Torr in 1 
	 minute.  The bypass valve closes with this error.

100	 “SV too high”,          
	 The sample line pressure is over 5 Torr for 2 seconds, 
	 when the sample valve is open and the roughing pump is 		
	 not off.  The sample valve closes with this error. 

101  	 “BP too low”,
	 The sample line pressure is below 0.5 Torr for 2 seconds,
	 when the sample valve is open and the roughing pump is
	 not off. This happens when BV is malfunction. SV and
	 BV are closed with this error.

102  	 “RP too high”,          
	 The chamber pressure did not reach 5 Torr in 2 minutes.
 
103  	 Reserved

104  	 “TP too high”,            
	 Turbo pump did not reach the full speed in 10 minutes.

105  	 “IG too high”,          
	 The ion gauge reading is over 2.1E-5 Torr for 6 seconds.

106 - 108 	 Reserved

109  	 “No TP controller”,    
	 The turbo pump controller is not detected.

110  	 “TP stop failed”,       
	 The turbo pump is not turned off in time, probably due 		
	 to probably due to miscommunication between the 			
	 main control board and the auxiliary control board.
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Error 	 111 – 120 	 These error conditions are detected by the 
turbo pump controller. Once one of these errors occurs, the UGA 
must be power cycled to clear the error.

111  	 “TP current”,           
	 Turbo pump controller output current exceeded 15 A.

112  	 “No TP connected”,           
	 No turbo pump is connected to the controller.

113  	 “TP overload”,          
	 Turbo pump controller output current exceeded 1.5 A 		
	 longer than 15 seconds.

114  	 “TP bearing hot”,       
	 Turbo pump bearing temperature is higher than 60 °C.

115  	 “TP hot”,               
	 Turbo pump heat exchange temperature is higher than 
	 60 °C.

116  	 “TP start”,             
	 Turbo pump did not reach the full speed at run up time.

117  	 “TP input voltage”,  
	 TP controller input voltage is lower than 16 V for 5 
	 seconds.

118  	 “TP op voltage”, 
	 TP controller operating voltage is lower than 10 V for 5 
	 seconds.

119  	 “TP low voltage”,       
	 TP controller Vp is 8V lower than nominal for 5 seconds.

120  	 “TP soft start”,        
	 Soft start ramp has not ended within the expected time.

121 - 125 	 Reserved

126  	 “Too many Errors”,      
	 More than 10 errors have occurred since errors were read 		
	 with the “ZERR?” command. The subsequent errors 		
	 are discarded. This error will not be displayed on the front 		
	 panel at all.  
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Chapter 5 

Calibration and Input Design

In This Chapter This chapter discusses procedures to help the user 
make accurate measurements with the UGA.  Sever-
al sections are devoted to calibration and correcting 
procedures.  The last sections discuss specific design 
for the pressure reduction.
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5.1 Mass Spectrometry Basics
	
	

	
	

	
	

	 5.1.1 How Mass Spectra are Interpreted

The RGA can perform both qualitative and quantitative analysis of 
the gases in a vacuum system. Obtaining spectra with the RGA is 
very simple.  Interpreting the spectra, that is, understanding what 
the spectra is trying to tell you about your vacuum system requires 
some work. The following sections will introduce some basic con-
cepts of Spectral Analysis emphasizing the main aspects of Residual 
Gas Analysis.  For additional information on the subject of Residual 
Gas Analysis refer to:

J. Drinkwine and D. Lichtman, Partial Pressure Analyzers and 
Analysis, AVS Monograph Series published by the Education Com-
mittee of the American Vacuum Society

Basford  et. al., J. Vac. Sci. Technol. A 11(3) (1993) A22-40 “Recom-
mended Practice for the Calibration of Mass Spectrometers for Par-
tial Pressure Analysis. Update to AVS Standard 2.3”.

For information on multiple linear regression analysis consult:

William H. Press, et. al., 1992, Numerical Recipes in C, The Art of 
Scientific Computing, Second Edition, Cambridge Univ. Press, sec-
tion 15.4, page 671.

Bevington, P.R., 1969, Data Reduction and Error Analysis for the 
Physical Sciences, New York, McGraw-Hill, Chapters 8-9.

A mass spectrum, taken in a real system, will almost always con-
tain signals from a mixture of various gases. Careful and complete 
interpretation of the spectrum (i.e. a complete spectral analysis) 
should reveal the identity, as well as the concentrations, of the vari-
ous components which have produced the spectrum.

The first step in the spectral analysis process is to correctly identify 
the mass-to-charge ratio of all the peaks in the mass spectrum. A 
well calibrated mass scale is essential to this task. See the RGA Tun-
ing Chapter in the RGA manual for a detailed description of the 
mass scale calibration procedure. 
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Once all the peaks have been labeled, the next step is to identify the 
residual gases that have produced the spectrum. A knowledge of the 
recent history of your system may provide very valuable clues as to 
the possible gases that may be residuals in the vacuum chamber. A 
familiarity with the standard spectra of commonly expected gases 
will generally help to determine the major and minor components 
in the system. Any peak in the spectrum may consist of contribu-
tions from molecular ions and/or fragment ions, or multiply ion-
ized species.  The qualitative spectral analysis is completed when 
all the peaks in the spectrum have been “uniquely assigned” to 
the components of a gas mixture, in complete agreement with the 
known fragmentation patterns of the components.

In cases where only the major components are of interest, some of 
the minor peaks of the spectrum will remain unassigned. If only a 
few species are being monitored, only the peaks corresponding to 
the substances of interest need to be assigned and monitored.

Notes on Fragmentation Patterns: The electron impact type of ion-
izer used in modern RGA’s almost always causes more than one 
kind of ion to be produced from a single type of gas molecule. Mul-
tiple ionization, molecular fragmentation and changes in the isoto-
pic composition of the molecule are responsible for the effect. All 
ions formed contribute to the mass spectrum of the molecule and 
define its fragmentation pattern. The identification and interpreta-
tion of mass spectra must begin with a knowledge and understand-
ing of the standard fragment patterns of atoms and molecules that 
may exist in the system. The standard fragment patterns of most 
molecules commonly encountered in residual gas analysis are well 
established and listed in the general RGA Literature. A very com-
plete library can also be accessed through the Gas Library utility 
of the UGASoft program. The Gas Library has a standard text file 
format, and can easily be read, extended or modified by the user to 
fit his individual needs.

Once the different components of a mixture have been identified it 
is possible to use the RGA to obtain quantitative values for the vari-
ous partial pressures. This section describes the basic steps needed 
to perform quantitative measurements with the instrument. The 

	

	
	

	

	 5.1.2 Partial Pressure Measurement
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formalism presented assumes multiple gas analysis, but is equally 
valid for single gas measurements. Please consult the suggested 
references for details and examples of these procedures.

The entire mathematical formalism used to derive the partial pres-
sures of a mixture based on a single mass spectrum is based on one 
assumption:

The total spectrum is a linear combination of the spectra of the 
different species that are present in the mixture.  In other words, 
the total spectrum is equal to the sum of the individual peaks that 
would be observed if each constituent were alone in the system.
In mathematical terms, the assumption stated above can be written 
as the following linear equation:

	 HM = ∑g hMg						      (1)
	

where:
g is an integer variable that represents the gases present (i.e. assign 
an integer to each gas starting with one)
M is an integer variable that represents the mass numbers for the 
entire mass range of the spectrum.
HM= total peak height (amps) of the spectrum at mass number M.
hMg= peak height contribution (amps) from gas g at mass M.
hMg is related to the fragmentation pattern, 	 the RGA’s sensitivity 
and the partial pressure of gas g by the equation:

	 hMg = aMg Sg Pg						     (2)

where:
aMg = Fragmentation factor of gas g at mass M: Ratio of ion signal at 
mass M to the ion signal at the principal mass peak for gas g.
Sg  = RGA’s partial pressure sensitivity factor for gas g, in amp/Torr 
(see Partial Pressure Sensitivity Factor below)
Pg = Partial pressure of gas g in the system.

Equations (1) and (2) are combined to obtain the system of equa-
tions:



Phone: (408)744-9040
www.thinkSRS.com

UGA Series Universal Gas Analyzers

Calibration and Input Design 5 – 5

	 HM  = ∑g  (Sg  aMg ) Pg					      (3)

Since all gases have more than one peak in their fragmentation 
pattern, the number of peaks (M) in a real spectrum is generally 
larger than the number of gases (g). As a result, the system of equa-
tions (3) usually has more equations than unknowns. This situation 
is sometimes simplified eliminating some of the extra equations; 
however, the best results are obtained using all the equations and 
a multiple linear regression procedure to calculate the best possible 
fit to the data. 

Obviously, accurate results can only be obtained if the constants 
aMg  and Sg  are well known for the RGA being used.

Note: The UGASoft program uses least squares fitting algorithm to 
automatically calculate the composition of a “typical residual gas 
environment” at the end of a spectral scan. Please see the RGA On-
Line Help files for details.

Standard fragmentation patterns (for example, the fragmentation 
patterns included in the Gas Library of UGASoft) can be used as 
a source of aMg  values in moderately quantitative determinations. 
However, when very precise numbers are desired, one should ob-
tain the appropriate fragment patterns by introducing pure gas 
into the RGA being used. The fragment  patterns must be obtained 
under the same conditions that will be used during regular spec-
tral analysis since they depend on many instrumental parameters, 
including: electron energy, emission current, ionizer design, mass 
filter settings, detector type, multiplier gain, etc. The principal mass 
peak of a fragmentation pattern is simply the most intense peak of 
the spectrum, and the intensity of all the other peaks in the pattern 
are normalized to its height for the calculation of fragmentation fac-
tors. Note that by our definition the aMg  value for the principal 
mass peak of any gas is equal to one. Principal mass peaks are 
used in the calculation of the sensitivity of the RGA to different 
gases as shown below.
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	 5.1.3 Partial Pressure Sensitivity Factors

The partial pressure sensitivity of the RGA to a gas g, Sg,  is defined 
as the ratio of the change (H-H0) in principal mass peak height to 
the corresponding change (P-P0) in total pressure due to a change 
in partial pressure of the particular gas species. H0 and P0 are back-
ground values.

Sg  = (H-H0 ) / (P-P0 )

The units of Sg  are of ion current per unit pressure (amp/Torr, for 
example). 

The sensitivity of the RGA varies with different gases, changes with 
time due to aging of the head, and is a strong function of the op-
erating conditions of the instrument. Careful quantitative analysis 
requires that the sensitivity factor, Sg ,  be determined for every gas 
which may be a component gas in the system being analyzed. The 
sensitivity factors must be obtained under the same operating con-
ditions that will be used during general partial pressure analysis 
since they depend on many instrumental parameters, including: 
ionization energy, emission current, mass filter setting, type of de-
tector, etc.

In order to separate the gain of the electron multiplier from the in-
trinsic sensitivity of the RGA, the sensitivity factors of the RGA are 
defined for Faraday Cup detection. A separate Electron Multiplier 
Gain Factor, is used to correct the ion signals when the electron 
multiplier is turned on. See the Sensitivity and Electron Multiplier 
Tuning sections of the RGA Tuning Chapter for details.

The basic procedure for determining the sensitivity of a particular 
gas in the RGA is the following:

•	 Introduce the pure gas into the vacuum system, at a 
	 known or calculable pressure (typically around 10-6 Torr).
•	 Measure the output signal from the RGA for the principal
	 mass peak of that gas using the Faraday cup detector.
•	 The ratio of this output signal to the pressure of the gas is
	 the sensitivity factor, Sg .
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During these measurements it is very important to ensure that the 
partial pressures of all other gases in the system are small enough 
so that they may be neglected. The sensitivity factors calculated 
can only be applied to situations where the RGA is used with the 
same operating parameters. See the Sensitivity Tuning section in 
the RGA Tuning chapter of this manual for more details on this 
calibration procedure.

A total pressure sensitivity factor is also needed by the RGA to 
convert the ion currents obtained during total pressure measure-
ments into total pressures. Total pressure sensitivity factors vary 
with different gases and share many of the properties of the partial 
pressure factors. They are determined by a procedure identical to 
the one described above, but with the partial pressure measure-
ments replaced by total pressure measurements.

The underlying assumption when using sensitivity factors in quan-
titative calculations is that there is a linear relation between the 
partial pressure and the corresponding RGA signals of the gases. 
Deviations from linearity are to be expected above 10-5 Torr due to 
space charge effects in the ionizer and ion-neutral scattering inter-
actions in the filter. A more thorough check of the RGA’s sensitivity 
involves measuring the RGA signals over several orders of magni-
tude of partial pressure to determine the range over which a linear 
relationship exists. The sensitivity factor for the gas is calculated 
as the slope of the “signal vs. partial pressure” response over the 
linear range.

UGASoft uses two sensitivity factors stored in the non-volatile 
memory of the RGA. The sensitivity factors, one for total pressure 
and one for partial pressure, are used as conversion factors between 
the ion currents received form the head and the pressure units se-
lected by the user. The sensitivity factors are measured with the 
Faraday Cup detector and can be updated or changed very easily 
by using the Sensitivity Tuning command in the Probe menu.  A 
separate Electron Multiplier Gain Factor, stored in the non-vola-
tile memory of the RGA, is used to correct the ion signals for the 
gain of the electron multiplier. The gain of the electron multiplier is 
highly mass dependent and defined relative to the corresponding 
FC signal. An automatic Electron Multiplier Gain Adjustment com-
mand, built into the program, can adjust the CDEM voltage for any 
gain between 10 and 106. Consult the RGA On-Line Help Files for 
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	 5.1.4 Single gas measurement example 

details on the automated tuning procedures built into the UGASoft 
program. Also see the Sensitivity and Electron Multiplier Tuning 
sections of the RGA Tuning Chapter for more general information.

The scan mass table of UGASoft offers scaling factors for all of its 
channels eliminating the limitations imposed by the single sensi-
tivity factor on multiple partial pressure calculations. For example, 
the scaling factors can be used to display correct partial pressure 
for all the species in a table if the ratios between the partial pressure 
sensitivities of the different components are known and only prin-
cipal mass peaks are used to monitor them. The scaling factors can 
also be adjusted to correct against the mass discrimination of the 
electron multiplier’s gain.

Important: Following current industry standards, the partial pres-
sure sensitivity factor stored at the factory corresponds to N2 mea-
sured at 28 amu with  ∆m10%=1 amu, default ionizer settings and 
Faraday Cup Detection.

Monitoring the concentrations of one or few components in a sys-
tem is easy in the absence of severe spectral interference.

Suppose a system where argon is measured at 40 amu (principal 
mass), in the absence of any other gases that contribute a signal at 
that mass value. The sensitivity to argon was previously measured 
at SAr=10-4 amps/Torr, and the electron multiplier is biased and its 
gain at mass 40 was previously measured at gCDEM=1.02x103  relative 
to the FC signal. 

The partial pressure of argon, PAr, is easily calculated measuring the 
intensity (i.e. peak height) of the ion current at mass 40, I40. 

	 PAr  = I40 / (gCDEM•SAr), units of Torr		  (4)

The peak value, I40 , can be extracted from a spectral scan or mea-
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sured directly using the single mass measurement mode of the 
RGA. For example, a 10-9 amp peak value corresponds to 9.8 × 10-9 
Torr of Ar.  Note that equation (4) is a particular case of equation 
(3), and that the fragmentation factor for the principal peak of Ar is 
one by definition.

 

The UGA has been calibrated at the factory to measure the partial 
pressure of nitrogen correctly.  For many purposes this will be suit-
able.  Overtime the calibration can change or operating conditions 
may change.  There are many factors involved in calibrating the 
UGA and interpreting the mass spectra.  To make accurate mea-
surements, the following conditions need to be met:

•	 The total pressure needs to be known.
•	 The main sensitivity factor needs to be calibrated. 
	 Sensitivity factors change as a factor of time due to aging 		
	 and periodic recalibration is necessary.
•	 For careful quantitative analysis, it is important that the 
	 sensitivity of the RGA be determined for every gas which 		
	 may be a component of the system.  Each gas component 
	 in the sample will fragment differently and will have 
	 slightly different sensitivities.
•	 Correct calibration of the mass scale is essential during
	 qualitative analysis for the correct assignment of mass 
	 numbers to the different peaks.  The mass scale will affect
	 the peak height if it is more than 0.3 amu out of calibration.
•	 The mass resolution of the quadrupole mass filter, ∆m10%, 
	 must be kept at or under 1 amu to avoid overlap between 
	 adjacent peaks. Changes in ∆m10% during the 
	 measurements (caused by aging, severe contamination and 	
	 large temperature changes) will cause variations in the 
	 sensitivity of the instrument and the shapes of the 
	 fragmentation patterns of the molecules, affecting all quan-		
	 titative measurements.
•	 The gain of the electron multiplier is mass dependent and 		
	 needs to be determined prior to performing measurements 	
	 with the device. The gain characteristics of the multiplier 		
	 change with time and periodic recalibrations are very 
	 important. 

The following sections of this chapter describe several procedures 

	 5.1.5 Calibration
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	 5.1.6 Effect of Total Pressure

designed to assure that all the calibration conditions described 
above are satisfied prior to a set of partial pressure measurements. 
All tuning procedures can be executed from UGASoftt program.  
Users writing their own programs can implement the procedures 
themselves, using the RGA Command Set and the instructions in 
the RGA manual.

All the tuning procedures require the ability to introduce pure gas-
es (or a mixture of gases of known composition) into the system 
and a reference pressure gauge.  All pressures are absolute; it is 
possible to make measurements in gauge pressure.

Important: Tuning should only be attempted after the unit has been 
warmed up (with the filament on and under typical operating con-
ditions) for at least one hour.
 

Increasing the total pressure at the inlet of the capillary will in-
crease the flow through the capillary.  The higher flowrate in turn 
will increase the pressure at the RGA.  This effect is not linear and 
in applications where the inlet pressure varies, the user needs to 
understand the flow at the inlet.  The flowrate or throughput of the 
capillary is characterized by

	    Q = C(Pin - Pout),

	
where Q is the throughput (a mass flowrate), C is the conductiv-
ity of the capillary, and Pin & Pout are the pressures at the inlet and 
outlet of the capillary.  The inlet pressure is much larger than the 
outlet pressure, which allows Pout to be approximated as zero.  The 
conductivity is a function of the capillary dimensions, the viscosity 
of the gas, and the pressure drop across the capillary.  This results 
in the throughput, Q, being proportional to the square of the inlet 
pressure.  The diaphragm pump dictates the pressure at the outlet 
of the capillary according to
	   

	
P

Q
Sout

DP

=
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where SDP is the speed of the pump.  The speed of the diaphragm 
pump varies with throughput according to its characteristic curve, 
referred to as a speed curve.  The speed curve is not linear. Because 
the pump has an ultimate vacuum it can achieve, the intercept of 
the curve is not even zero.  The aperture and turbo pump respond 
linearly to Pout.  Although all these factors can be modeled, the over-
all response of the UGA to total pressure is best characterized ex-
perimentally.  A short experiment with the specific gas of interest, 
equipment and operating conditions will yield a curve describing 
how the pressure at the RGA varies with Pin.

Each system is specified for one inlet pressure, the design point, 
which is atmospheric pressure for the standard capillary. The capil-
lary accomplishes the first stage of the pressure reduction from the 
chosen design point to about 1 mbar.  The aperture in the UGA is 
fixed, and designed to reduce the pressure from 2 mbar to about 
5×10 -6 mbar at the RGA.  Each capillary is designed for the specific 
inlet pressure; mainly by choosing length and bore diameter.  The 
inlet pressure to the capillary can be applied up to 10 mbar.  Because 
the UGA has a separated bypass pump, the inlet pressure can go as 
high as turbo pump could hold the proper pressure for the RGA 
(below 1x10-4 mbar).  Operating the inlet at high pressures would 
cause two unacceptable effects:  First, the turbo pump exhaust pres-
sure would be excessive and slow the pump.  The high pressure 
would increase the work load and cause excessive heating of the 
pump bearings.  In the UGA, these fault conditions are prevent-
ed.  The turbo pump contains a thermocouple which monitors the 
bearing temperature and shuts down the pump before it overheats.  
Also, the system microcontroller will shutoff the turbo pump and 
will give the error message.  The second effect is excessive pressure 
at the RGA, which can degrade the filament if it occurs for long 
periods.  This fault condition is also prevented by two means.  The 
RGA will shut off the filament when it senses the pressure is high 
and the system microcontroller will close the sample valve.  These 
operating limits restrict the dynamic range of the UGA with respect 
to increasing the inlet pressure above the design point.  The instru-
ment has little “head-room” and the capillary should be designed 
for the maximum expected pressure.

Below the design point, the UGA can tolerate large decreases in the 
inlet pressure.  The ultimate vacuum of the diaphragm pump lim-

	 5.1.7 Operating Off the Design Pressure
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	 5.1.8 Total Pressure and Composition

its the lowest pressure at the outlet of the capillary, typically to 0.5 
mbar.  This pressure is the only operating limit; below it gas would 
flow out of the RGA.  With respect to measurements, operating the 
outlet of the capillary near the ultimate vacuum of the diaphragm 
pump is inadvisable.  At the ultimate vacuum, the flow through the 
pump is effectively zero.  Operating the UGA with zero flow oblit-
erates the fast response time of the instrument.  While there are no 
physically harmful effects to operating below the design point, the 
ability to make measurements is lost at very low inlet pressures.  
Best performance of the system requires that the outlet of the capil-
lary is between 1 to 3 mbar.  The later section of this manual dis-
cusses in greater detail the design of capillaries.

	
The RGA measures partial pressure of the components in a gas 
stream.  For ideal gases, the partial pressure is related to composi-
tion by
	   

	
where Pi is the partial pressure of the i-th component, xi is the mole 
fraction of the i-th component and PT is the total pressure.  It is evi-
dent from this equation that a measurement of Pi cannot determine 
both xi and PT.  To determine the composition, xi, a value for PT must 
be known.  In many applications total pressure is constant and 
therefore partial pressure is proportional to mole fraction.  When 
total pressure is not constant, a method of determining its value 
must be employed to allow composition to be determined.

In theory, the sum of the partial pressures determines the total pres-
sure, i.e.
		

In practice, this summation requires care.  For example, when using 
the P vs. t mode to acquire data, make sure to record all the ma-
jor components of the gas being analyzed.  Beware of overlapping 
peaks; these complicate the analysis.  For example, consider a 50/50 
mixture of nitrogen and carbon dioxide.  The parent peaks for these 

P x Pi i
T=

= ∑PiPT

i
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gases are at 44 and 28.  Referring to the library in the software shows 
that nitrogen produces a peak at masses 28 and 14 that are 93% and 
6% of the partial pressure and that carbon dioxide produces peaks 
at masses 44 & 28 that are 78% & 9% of the partial pressure.  For a 
1000 mbar total pressure, the spectrum would show peaks at 28 & 
44 with heights of 510 and 390 mbar.  An error can be demonstrated 
by using these peak heights and reversing the calculation, while ig-
noring the interference.  The carbon dioxide partial pressure would 
be correctly calculated as 500 mbar (=390/0.78), but the nitrogen 
would be erroneously calculated as 548 mbar (=510/0.93) mixture.  
The mixture appears to be present at a total pressure of 1048 mbar 
and a composition of 52/48.  The correct calculation would first 
subtract the component of the peak at mass 28 which was caused 
by carbon dioxide, before calculating the nitrogen partial pressure.  
More discussion of the quantitative analysis of complex mixtures 
can be found in the texts listed in the Reference section.

 

All quantitative calculations performed with the RGA rely on the 
assumption that there is a linear relation between the partial pres-
sure and the corresponding RGA signals of the gases. Each gas ion-
izes differently, and its ions make it through the mass filter with 
different efficiencies. As a result the proportionality constant relat-
ing the ion current of a gas to its partial pressure is dependent on 
the specific gas. 

Two calibration factors are used in the UGA system: the RGA sen-
sitivity and the pressure reduction factor. The RGA sensitivity is 
the factor which converts the ion current that is measured by the 
electrometer to partial pressure at the ionizer.  The pressure reduc-
tion factor accounts for the large pressure reduction performed by 
the two stage inlet (capillary and aperture). Determination of these 
factors requires comparing the system with a known-accurate pres-
sure gauge and calculating the factor that makes the UGA agree 
with the standard.  Calibration is not necessary on a frequent inter-
val, but is required whenever operating conditions change.

The RGA intrinsically measures an ion current, which is propor-
tional to the partial pressure at its ionizer.  While the software can 

5.2	 Calibration of Partial Pressure
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be set to report ion currents, most users will need to measure par-
tial pressure at the inlet of the capillary.  To convert between the 
two, the partial pressure reported by the software is calculated by 
the formula:

	
	

The pressure reduction factor is a function of the capillary dimen-
sions, the performance curve of the pumps, and the dimensions of 
the aperture. The sensitivity factor is a function of the precise di-
mensions of quadruple and ion optics, the state of the detector, the 
ionizer filament, and the four parameters which control the filter 
(electron energy, focus voltage, ionizer current, and ion energy).  In 
the equation above, the two factors are unknown.  During calibra-
tion only the standard partial pressure and measured ion current 
are known.  Therefore, both factors cannot be determined; only the 
overall factor can be determined.  Both factors can be determined 
if a second reference pressure gauge is introduced into the RGA 
chamber.  While this approach would yield another reference pres-
sure and allow both factors to be accurately determined, it has no 
practical benefit.

Because only the ratio of the two factors is relevant, strictly speak-
ing, one of the factors could be chosen to be any number.  An obvi-
ous choice is to make one of the factors equal to one and use only 
the other.  Because the sensitivity factor is stored in the RGA, this 
choice causes practical problems.  The RGA firmware limits the 
sensitivity factor to reasonable values.  The sensitivity factor must 
be on the order of 10-4 to 10-5 A Torr-1, which are typical values.  The 
pressure reduction factor is stored by the software in each .rgadata 
file.  With the two values stored in different locations, there are ben-
efits for using each to account for various components of the overall 
calibration factor.

Both factors cannot be determined; therefore, each time the instru-
ment is calibrated, one of the factors will be assumed to be correct, 
and the other will be adjusted to make the measured and reference 
values agree.  The strategies for using each value are discussed in 
the following sections, starting with the basic technique that was 
performed at the factory.

P  =  ion current (A)  pressure reduction factor 
sensitivity factor (A Torr )

=  ion current (A) overall factor (Torr A )i -1
-1× ×
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Initially, a default value is stored in the RGA for its sensitivity 
factor.  This factor is displayed in the Status panel of the software 
(menu View > Show Status Panel).  This value was determined at 
the factory using a reference ion pressure gauge.  Users can resort 
to this default value when they wish to completely recalibrate the 
instrument.  The pressure reduction factor is calibrated using the 
partial pressure of nitrogen present in air using the following steps:

1.	 Determine the barometric pressure, which is typically 
	 reported in “in Hg”.  Example: on a typical clear day the 		
	 pressure is 29.95 in Hg or 761 Torr (1 in Hg = 25.4 Torr).
2.	 Nitrogen is naturally present at 78.1% of total pressure.  
	 Multiply by this factor to yield the partial pressure.  Exam		
	 ple: on that day nitrogen is present at 594 Torr.
3.	 Gases break into molecular fragments in the ionizer.  For 		
	 common gases, fragmentation factors exist that indicate 		
	 what fraction of the molecules remain intact.  For nitrogen 
	 92.6% of the molecules will remain intact and will be mea-		
	 sured at mass 28.  Multiply the partial pressure by this 
	 fraction to determine the reference value.  Example: the ref		
	 erence value would be 550 Torr.
4.	 With the pressure reduction factor disabled (or set to 1), 
	 measure the peak at mass 28.  Example: the system 
	 indicates 1.3 × 10-6 Torr at mass 28.
5.	 The pressure reduction factor is the reference value 
	 divided by the measured value.  Example: the factor is cal-		
	 culated to be 4.2 × 108 for this instrument.
6.	 Enter this number in the pressure reduction factor dialog 		
	 box and check the enable box.

This completes the calibration.  All modes of the software will now 
report partial pressure at the inlet to the capillary.  Be sure to record 
these values as they can be used to diagnose system performance.  
The pressure reduction factor is saved in the registry and .rgadata 
file.

	 5.2.1 Initial Calibration
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	 5.2.2 Basic Recalibration

Some situations will require recalibration of the instrument.  For 
example:

•	 aging of the diaphragm pump and ionizer filament
•	 small changes in the total pressure at the capillary inlet
•	 small dimensional changes to capillary and aperture

For users of one capillary and one input stream, an easy method of 
making small changes to the calibration values is available with the 
Sensitivity Tuning feature of the software.  Under this method, we 
assume that the pressure reduction factor is correct and change the 
RGA sensitivity factor.

Nitrogen is the most common recalibration gas, and in this exam-
ple, we assume that the partial pressure of nitrogen in air is used 
as a reference.  While air is convenient, the recalibration can be per-
formed with any test gas as a reference. Follow these steps to reca-
librate the UGA: 

1.	 Make sure that the pressure reduction factor is enabled 
	 and correct in the dialog box that appears under the 
	 “Utilities|Pressure Reduction...” menu item.  
2.	 Setup the UGA to sample the reference gas.
3.	 Choose the “Head|Sensitivity Tuning...” menu item to 
	 make the Sensitivity Tuning dialog box appear.  Make sure 
	 the Measurement Mode is set to Partial Pressure and that 
	 the Mass Selection is set to the parent peak of the reference 
	 gas.
4.	 Enter a value in the Reference Pressure Reading edit box 
	 that is the expected value for the pressure at the capillary 
	 inlet.  This value should be adjusted for the fragmentation 
	 factor as done above (92.6% for peak 28 from nitrogen).  
	 As in the example in the previous section, the reference 
	 reading is 550 Torr for nitrogen in air at a barometric 
	 pressure of 29.95 in Hg.
5.	 Observe the value in the Sensitivity Factor text box and 
	 then press the Measure button.  A new value will be 
	 displayed in the text box, which should be close to the old 
	 value.
6.	 Press the Accept button to store the newly calculated value 
	 into the RGA or the Undo button to restore the previous 
	 button.
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The instrument is now recalibrated.  Note that the new sensitivity 
factor is only correct when used with .RGA files that contain the 
matching pressure reduction factor.  This procedure can be repeat-
ed frequently to make minor adjustments to the overall sensitivity 
factor.  Because the range of the RGA sensitivity factor is limited 
by firmware, this procedure cannot be used to account for large 
changes in the overall sensitivity factor.

The UGA capable of being used over a variety of operating con-
ditions, which in turn require different overall sensitivity factors.  
Examples are:

•	 one UGA system used with multiple capillaries
•	 measurements of gas streams at different total pressure, 
	 temperature, or composition
•	 measurements at multiple ionizer conditions

The RGA sensitivity factor is not meant to be directly adjusted by 
the user.  The software only allows this value to be changed via the 
Sensitivity Tuning dialog box using a reference gauge reading.  Us-
ers cannot type a new value into the Sensitivity Factor text box.  In-
stead, the Pressure Reduction Factor feature is provided to account 
for widely varying operating conditions.  

The Pressure Reduction Factor is stored in the .rgadata files.  When 
using the UGA with various operating conditions, one .rgadata file 
can be made for each set of conditions.  Each of these files will con-
tain a different pressure reduction factor.  The procedure to deter-
mine the pressure reduction factor is the same as used in the Initial 
Calibration section above.  Briefly: disable the pressure reduction 
factor, compare the measured value with a reference, and calculate 
a new pressure reduction factor.  When determining the pressure 
reduction factor for each set of conditions, make sure that the RGA 
sensitivity factor has not been changed.

To use the UGA at one of the multiple conditions, connect to the 
UGA, make sure the RGA is turned on, and simply load the ap-

	 5.2.3 Calibration for Multiple Operating Conditions
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	 5.2.4 Calibration with Fixed Reservoir

	 5.2.5 Corrections

		  5.2.5.1 Correcting for the Chamber Background

propriate .rgadata file.  The software will now be ready to make 
measurements.

It is worth restating that the pressure reduction factor is only ac-
curate when used with the matching RGA sensitivity factor.  The 
value in the RGA electronics can be changed by other users, so the 
RGA sensitivity factor should be recorded to ensure correct usage.

Air is a convenient calibrant gas for the UGA, but only provides 
nitrogen as a useful reference.  The other major components, e.g. 
oxygen, water, and carbon dioxide, are not present at reliable con-
centrations.  For more precise calibrations a reservoir and pres-
sure gauge can be used as a calibrant.  When using this method, be 
aware that the UGA continuously draws 1-5 milliliter per minute of 
gas, depending on the capillary.  The reservoir should be large or 
the total pressure will change quickly.
 

Even with the sample flow and bypass flow valves closed, there 
will be a noticeable background in the mass spectrum.  This back-
ground in the analyzer chamber is caused by outgassing from the 
chamber surfaces and gas production from the ionizer of the RGA.  
These two processes account for the ever present background of hy-
drogen, water, nitrogen, oxygen, and carbon dioxide seen in high 
vacuum. The outgassing of water can be minimized by extensive 
pumping with both valves closed; typically the system can achieve 
water partial pressures around 1 × 10-8 mbar.  The other process 
(ionizer) is fundamental and cannot be reduced. The ultimate vac-
uum of the turbo pump causes nitrogen to be present at no lower 
than 2 × 10-9 mbar and oxygen at 1/4 of that level.  Carbon dioxide 
from the ionizer will be present at levels from 10-9 to 10-7 mbar.  The 
software contains a background subtraction feature that allows the 
chamber background to be removed from the mass spectrum.



Phone: (408)744-9040
www.thinkSRS.com

UGA Series Universal Gas Analyzers

Calibration and Input Design 5 – 19

The background spectrum is correctly measured with the sample 
valve closed and the bypass valve closed.  When the bypass valve 
is open, the background pressure at the chamber is rising due to 
the backstreaming through the bypass valve. However, the back-
streaming components will be flushed out when the sample valve 
is open.  Therefore, the background spectrum should be obtained 
with both valves closed.  The software can only subtract two spectra 
when they cover the same mass range.  Set the software to acquire 
the histogram mode spectrum at the speed, range, and schedule 
you require.  To obtain a background subtracted spectrum, follow 
these steps:

1.	 Measure one complete histogram mode spectrum with the 
sample valve closed.  If the software was set to scan on a continuous 
schedule, you can select “Stop at the End” from the “Scan” menu 
to stop when the current scan in progress is complete.  The data 
displayed must be a complete scan, and be measured with the same 
parameters as the scans to follow. Save this background data to a 
.rgadata file.

2.	 In a new scan, under the Scan Settings, expand “More Op-
tions” group of the Histogram mode, and select “Enable Back-
ground Subtraction”. Provide the data file saved in the previous 
step, and select “Scan Data - Reference” option.   These settings 
would  produce new spectra with the background spectrum sub-
tracted.

3.	 Open the sample flow valve and start the scan.  The newly 
acquired spectra are the background corrected result.

The ability to subtract background is limited by signal proportion-
al noise, which is typically present at between 1-10% of the sig-
nal magnitude.  Because this noise originates in the ionizer of the 
RGA, subtraction cannot remove much more than 90% of the back-
ground.  This limits the ability to see small changes of less than 1% 
at the same mass as peaks present in the background.

As discussed above, the UGA is calibrated at one mass number.  
Because every gas behaves differently, analog scans can only show 
peak heights that are correct at the one mass number.  It is not pos-
sible to correct the analog and histograms at every mass number.  

		  5.2.5.2 Correcting for Multiple Species
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	 5.2.6 Operation with Condensable Gases

The RGA would have to know what species was causing the ion 
current at each mass. As an example: is ion current at a m/z of 16 
caused by a fragment of H2O (O+1), a fragment of  O2 ( O2

+2, or O+1), 
or CH4

+1 .  Many of the peaks in a mass spectrum have multiple 
sources.  To demonstrate this to yourself, use the library search 
on almost any single mass number.  Except for a few values, the 
search will retrieve multiple species for almost all the low mass 
peaks.  Without knowledge of what species is causing what peak, 
the correction cannot be made automatically.  Practically, this is not 
a problem; the histogram and analog modes are intended to show 
qualitative composition.

Data tables in all scan modes contain a scaling factor for each spe-
cies.  These factors are provided to resolve the problem with the 
mass spectrum just discussed.  The user can use these factors to tell 
the software how to correct for each peak.  To determine the correct 
calibration factor to use, you must know (or assume) what species 
is causing each peak and choose masses that are not complicated 
by other species.  Choosing the correct peaks is complicated and re-
quires understanding of the mass spectrum.  For instance in a 50/50 
mixture of nitrogen and carbon dioxide, you cannot use mass 28 to 
measure the nitrogen.  With this mixture, about 10% of the peak at 
28 would be caused by a  fragment.  A better choice would be to use 
the peak at 14 to measure nitrogen.  Once you have chosen a mass 
that is representative of each species of interest, you then refer to 
published fragmentation factors (see references) to determine how 
to correct back to the parent peak.  Even if the instrument was cal-
ibrated for nitrogen, it was likely calibrated on the peak at 28.  The 
peak at 14 will not be correct; it will be about 7% of the correct value.  
Entering 14.2 (1/0.07) as a calibration value in the table parameters 
allows the software to correct the partial pressure reading.  Similar 
calibration factors are entered for each species being measured.  A 
calibration gas of known composition makes process of determin-
ing factors easy.  First make a measurement of the standard with all 
the factors set to 1.  From this measurement, a correction for each 
species can be calculated and entered into the tables.  The referenc-
es listed at the end of this manual contain discussions about how to 
interpret mass spectra from RGA’s.

	
The UGA is designed to sample gases that are nominally at room 
temperature.  Under these conditions, any species that is a gas in 
at inlet conditions can be expected to travel through the instrument 
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without condensing.  Without a heat input, a gas will cool as it ex-
pands through a capillary and pressure reduction aperture (accord-
ing to its Joule-Thompson coefficient).  In the UGA system, the ab-
solute pressure difference across the aperture is small and the flow 
rate is small; under these circumstances the interior metal surfaces 
can provide sufficient heat to the expanding gas to keep it from 
condensing.  If problems due to condensation are suspected, the 
capillary with the heater can be used (Option#3).  The goal of heat-
ing the capillary is to increase the heat transfer rate to the sample 
gas.

When the gas being measured is significantly hotter than the UGA 
system, condensation is likely and presents a problem.  If the spe-
cies at the inlet are gases only at temperatures above room tempera-
ture, they can condense when they reach the UGA.  The condensed 
material will continually build up in the UGA and cover the valve 
seats and aperture.  Two approaches can prevent this problem: con-
trol the location of condensation or prevent condensation.  The first 
approach can be very simple:  place screens or metal plates before 
the inlet to provide sacrificial surfaces for condensation.  The sac-
rificial surfaces should have good thermal connections to the outer 
walls so that they stay at room temperature.  These surfaces will act 
like a trap and prevent the unwanted materials from passing into 
the UGA.  The second approach involves operating the entire UGA 
inlet above the condensation temperature of the condensable ma-
terial.  This may be feasible if the operating temperature is below 
100 °C.  All the tubing components in the inlet can be heated to 100 
°C or more.  The electronics and pumps cannot operate at elevated 
temperatures.  This approach (keeping the tubing hot and electron-
ics cool) is a difficult task and therefore is not recommended.

The gas handling subsystem is designed to achieve several goals:

•	 reduce the pressure of the sample gas to the operating 
	 range of the mass spectrometer (<10 5 mbar)
•	 provide a quick response time to changes of sample 
	 composition at the inlet
•	 allow for easy connection to system being measured
•	 use conventional materials

5.3	 Pressure Reducing Inlet
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If only the first goal where important a single stage pressure reduc-
tion would be suitable.
 
For example, about 50 cm of 50 mm capillary would perform the re-
quired pressure reduction.  In a single stage design, all the gas that 
enters the capillary is delivered to the spectrometer chamber.  For 
a 80 l s-1 pump, the flowrate at the capillary inlet is 80 nL s-1 !  The 
velocity of the gas near the capillary inlet is very small.  To demon-
strate, the figure at the right shows the end of a 1/16 OD capillary 
and a hemi-spherical boundary of the same diameter.  The time it 
would take to drain the volume inside the boundary is a measure 
of the response.  For the small volumetric flowrate in this example, 
it would take 30 seconds to drain the tiny volume.  This low speed 
implies that the capillary relies on diffusion or forced convection to 
respond to concentration changes.  

The effect of a low flowrate on leak detection is catastrophic.  Imag-
ine trying to locate a leak by moving the capillary tip around a fit-
ting on a gas line.  With the capillary in the example above, you 
could be 1/16 of an inch away from the leak source and not detect it 
for 30 seconds.  To locate the leak, you would either have to move 
incredibly slow, or be exactly at the leak.

 
Low flowrates also severely restrict the inlet.  At the left is shown a 
capillary with a syringe tip filter installed.  The gap between the fil-
ter element and the end of the capillary (about 1/16 inch in this ex-
ample) creates a dead volume.  If this volume is approximated to be 
well mixed, the time constant is over 5 seconds.  The time constant 
relates to the rate at which a system responds to a step change and 

is characterized by the familiar [ ]1 − −exp t tc   response.  In this ex-
ample, a sudden change outside the filter would not be completely 
detected for over 15 seconds.

	
To achieve fast response, the UGA uses a bypass flow configuration, 
which draws 200-1000 times larger flowrates through the capillary.  
The same amount of sample is delivered to the spectrometer.  As the 
name implies, most of flow is bypassed around the spectrometer.  
Also the pressure drop across the capillary is now only a factor of 
1000 (as opposed to 1 billion).  This means the capillary can either 
have a larger bore or be shorter than in a single stage system.  The 
lower pressure drop makes feasible many capillary materials com-
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monly used in gas chromatography.  The following sections discuss 
details of the flow of the sample gas within the instrument.
 

The pressure and flowrates of the sampled gas can be calculated 
with simple formulas.  The calculations here assume that gases be-
have ideally, which is a reasonable approximation at the tempera-
tures and pressures involved.  Actual system performance com-
pares well with these simple calculations.

The pressure drop across a length of tube is related to the flowrate 
and dimensions by:

	  	  						      (1) 

where Q is the throughput, C is the conductivity, and ∆P is the 
pressure drop.  Throughput is a measure of mass flowrate com-
monly used in vacuum systems.  Typical units for Q are mbar liter 
s-1, which unless stated otherwise, implies a standard temperature.  
At STP (273.15 K and 1013.25 mbar) 1 mbar liter s-1 is equal to 1.013 
cm3 s-1 (sometimes abbreviated sccs).  The conductivity of various 
geometries is calculated with the standard formulas available in 
texts discussing vacuum (see References).

The pressures and flow at every point in the system is determined 
by applying equation 1 to each section of tube.  A simplified flow 
schematic of the UGA is shown below.
 

	 5.3.1 Flow Calculations

( )Q C P P C Pin out= − = ∆
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Fig. 5-1. Schematic of key components of system.

For this example there are four points at which the pressure is un-
known, Pa, Pb, Pc, and Pd.  Applying equation 1 between each pair 
of points will yield a set of equations to solve.  First all the sampled 
gas flows through the capillary:

	     							       (2) 

Because Pa >> Pb , the approximation can be made.  When the flow 
reaches the aperture it is split into two streams, bypass and sample.  
The sample flow is a small fraction of the total flow, so we can as-
sume that the bypass flow is equal the total and write the equation 
from the tee to the diaphragm pump as:

	  bBPtotal PSQ ×= 				    	 (3) 

where SB is the speed of the Bypass diaphragm pump and has the 
same units as conductivity (liter s-1 ).  The flow through the aperture 
is:

	  		  					     (4) 

Ccap (Pa - Pb ) ≅ CcapPa  Qtotal =

Cap (Pb - Pc ) ≅ CapPbQsample =
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where again the large pressure drop allows the approximation to 
be used.  Lastly, the turbo pump is an active component that is char-
acterized by

	   							       (5) 

where S is the speed of the pump and has the same units as conduc-
tivity (liter s-1 ).  For the pump in the UGA, the speed is a constant 
at 80 liter s-1 (except for He and H2).  

The speed of the diaphragm pump is not a constant; it is a function 
of the inlet pressure.  A typical speed curve is shown in the graph 
below.

 

Fig. 5-2. Speed curve for a diaphragm pump.

The curve shows an important feature: the speed goes to zero at a 
finite pressure.  This pressure is the ultimate pressure of the pump.  
At this pressure, gas travels backward through the pump at the 
same speed at which it is being pumped forward.  Therefore, even 
though the pump is still operating, it effectively has no speed.

Equations 2 to 5 completely describe the system.  Solution of the 
entire set would determine all the unknowns, except that there are 
more unknowns than equations.  Typically, the inlet pressure is 
known and the desired pressure at the spectrometer is known leav-
ing 5 unknowns.  To simplify the calculations, Pb is chosen to be an 

Pc = Qsample / S

inlet pressure (mbar)
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	 5.3.2 Diaphragm Pump

acceptable value and the remaining values are solved for.

These equations demonstrate some important characteristics of the 
UGA.

•	 The pressure in the spectrometer chamber is directly 
	 proportional to the pressure at the exit of the capillary and 
	 largely controlled by the aperture.  Choosing a different 
	 aperture has insignificant effect on the remainder of the 
	 system.
•	 The mass flowrate through the capillary is insensitive to 
	 changes in pressure at the exit of the capillary.  This 
	 characteristic is very helpful to predicting the performance 
	 of different capillaries.  If this where not true, the exit 
	 pressure of the capillary would be complexly related to the 
	 speed curve of the diaphragm pump.  (This can happen 
	 when designing capillaries for low pressure).
•	 The pressure at the exit of the capillary is dominated by the 
	 speed curve of the diaphragm pump and the mass flowrate 
	 through the capillary.  

These last two characteristics greatly simplify the selection of alter-
nate capillaries and is discussed later in this chapter.

	

	

 
Fig. 5-3. Measured pumping speed vs. the pressure 
	   at the pump inlet for the pump in the UGA.
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	 5.3.3 Turbo Pump

A measured speed curve for the diaphragm pump is shown in the 
Figure 5-3.  The speed is the volumetric flowrate at that pressure.  
Because mechanical pumps have much lower flowrates than turbo 
pumps, the speed is usually expressed in volume per minute.  A 
pressure of 2 mbar is a typical operating point for the UGA, which 
means the pump speed is 1.8 liter min-1 .  The mass flowrate at the 
diaphragm pump and capillary inlet are the same.  At the higher 
pressure of the capillary inlet, 1000 mbar, the corresponding volu-
metric flowrate is 3.6 milliliter min-1.  The simple relation 

	  	

is a good approximation as long as temperature is constant.  The 
speed is 2.6 liter min-1 at 5 mbar, which corresponds to 13 milliliter 
min-1 at 1000 mbar.  The turbo pump only operates with exhaust 
pressures up to approximately 5 mbar, which limits the useful 
range to that shown in Fig. 5-3.  Thereby, capillaries are always cho-
sen to draw volumetric flowrates of 1-10 ml min-1.  The complete 
speed curve would keep increasing up to the pumps specification 
of 13 liter min-1 at atmospheric pressure.

The ultimate pressure of the diaphragm pump can age, mainly by 
degradation of the valve seats.  This aging will shift the zero inter-
cept of the speed curve (Fig. 5-3) to higher pressures.  For many 
operating pressures the effect is minimal, but pressures near the 
ultimate pressure will show drastic speed changes.  The implica-
tion is that operating the UGA near the ultimate pressure of the dia-
phragm pump requires careful monitoring and should be avoided 
when feasible.

 

The pump attached to the spectrometer chamber is hybrid turbo-
molecular/drag pump.  The hybrid design of this pump allows it to 
exhaust at high pressure (relative to conventional turbomolecular 
pumps).  The pumping speed is constant at the nominal value of 80 
l s-1 over a large range of exhaust pressures.  As the exhaust pressure 
approaches the maximum value, the speed begins to drop.  Fig.5-4 
shows a representative turbo pump speed curve, overlaid with the 
speed curve of the diaphragm pump.  The two curves overlap for a 
small region of pressures, which determine the operating range of  
the system.

P1V1 = P2V2
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	 5.3.4 Capillary Design

In the case the UGA, the overlapping region is 1-5 mbar.  As the 
turbo pump exhaust pressure increases approaches 5 mbar, the 
work it performs will increase.  The current monitor display on 
the front panel is a good indicator of the power consumed by the 
pump.  Running the pump near its limit mainly causes the bearing 
temperature to increase.  The turbo pump controller will detect if 
the bearings are overheating and avoid damage by shutting down 
the pump.  Long term operation near the temperature limit mainly 
will age the bearings more quickly.  The only advantage to operat-
ing the turbo pump at higher exhaust pressures is an increase in 
the flow rate through the capillary.  The higher flowrate can help 
response time, but given the cost of a turbo pump rebuild, response 
time is better addressed through capillary design.
 

The inlet uses a bypass configuration that results in a fast response 
time. A large flow is drawn through the capillary tube, which drops 
the pressure 3 decades.  The typical capillary used at atmospheric 
pressure has a bore diameter of 0.175 mm and a length of 1.5 m.  Any 
number of combinations of length and bore diameter can achieve 
the same flowrate and pressure drop.  Capillaries are available in 
several materials.  The factors affecting the choice of capillary are:

Fig. 5-4. Representative speed curves for two pumps.  The speed values have 
been scaled to show both pumps on the same graph.  The pressure is the ex-
haust of turbo and the inlet of the diaphragm pump.
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•	 inlet pressure
•	 required response time
•	 distance to sample point
•	 material restrictions
•	 cost

The possibilities for capillary choice are numerous, and SRS offers 
only a few types.  The standard capillary shipped with the UGA is 
mainly provided to test the system and provide a reference.  The 
following sections contain some guidelines to designing a capillary 
suited to the users application.

To choose the dimensions of the capillary, three parameters must 
be fixed: the inlet pressure, exit pressure, and flowrate.  These three 
values allow the conductivity to be determined (equation 1).  A 
typical design point is an exit pressure of 1-2 mbar and a corre-
sponding flow rate of 1.5 to 3.5 milliliter min-1 (see Fig. 5-3).  The 
inlet pressure is determined by the users application.  The capillary 
conductivity is a function of the geometry, pressure, temperature, 
and gas properties.  A common formula for air flowing through a 
tube at 20 °C is

	   C d
L

P P
=

+135
2

4
1 2 					     (6) 

where C is the conductivity in l s-1 , d and L are in cm, and the pres-
sures are in mbar.  More general formulas including temperature 
and viscosity are contained in the texts listed in the references.  This 
formula also assumes laminar flow.  

There are many approximations used in equation 6 and users may 
be concerned about its accuracy.  The formula shows that the con-
ductivity is a strong function of diameter.  As a practical conse-
quence, this strong dependence means the standard manufactur-
ing tolerances on bore diameters will cause more uncertainty than 
the formula itself.  A typical 0.005 inch bore capillary might have 
a ±10% tolerance.  While it is reasonable that the bore could vary 
from 0.0045 to 0.0055 inch, this uncertainty causes the conductivity 

	 5.3.5 Length & Bore
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to vary by about ±40%.  Use the standard formulas as a guide, but 
cut the capillary long to begin with.  Measure the actual perfor-
mance and trim as necessary.

 
The chromatography industry uses a large variety of capillaries, 
from which we can select capillaries for the UGA.  The figure be-
low shows the conductivity for several commonly available bore 
diameters.
 

	
Fig.5-5. Conductivity of five different capillaries as a function of 
length.  The curves are labeled with the bore diameter in thou-
sandths of an inch.  Both axis are logarithmic. 
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As an example, consider a capillary for atmospheric pressure and 
an capillary exit pressure of 1 mbar.  From the speed curve for the 
diaphragm pump, the throughput, Q, is 2.5 × 10-2 mbar liter s-1 (Q 
= P x S) and the required conductivity is 2.5 × 10-5 liter s-1.  The hor-
izontal dotted line in Fig. 5-5 shows that for each capillary diame-
ter there is an appropriate length.  The application dictates which 
bore diameter is appropriate.  If the system being measured was far 
away from the UGA, 1.8 meters of the 7/1000 capillary would be 
best.  On the other hand, for something close 0.9 meters of 5/1000 
would be less expensive.  The gas velocity through the capillary 
quickly reaches the speed of sound.  Thereby, until the capillary be-
comes very long, it is not an important contributor to the response 
time of the UGA.

Users will find vendors of gas chromatography supplies a good 
source for capillaries and fittings.  Capillaries are available in many 
materials.  No material is ideal for all applications. The following 
table list features of several materials:

material min. bore 
diameter

advantages disadvantages

stainless steel 0.005 in • rugged
• high tem-
perature
• durable con-
nections

• difficult to cut 
without clog-
ging the bore
• marginal flex-
ibility

PEEK 0.005 in • highly flex-
ible
• can be cut by 
user

• weaker con-
nections

glass lined 
plastic

0.002 in • smallest bore • cost
• not flexible
• low tempera-
ture

Three conventional methods are available for making connections 
to the capillaries: metal compression fittings, graphite seals, and 
O-ring seals.  Metal compression fittings are suitable for stainless 
steel tube.  The steel is capable of deforming to make the seal.  The 

	 5.3.6 Materials and Fittings
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	 5.3.7 Extensions

outside diameter of plastic capillaries is not round enough to make 
a good seal to metal ferrule.  Graphite ferrules in a metal fitting 
are a better choice.  The graphite will conform to any irregulari-
ties in the surface of the capillary. In addition, the graphite ferrule 
does not permanently deform the capillary as a steel ferrule would.  
O-ring seals, e.g. Ultra-Torr, make good seals.  They only lack in the 
ability to operate at high temperature.
 

As discussed in the previous section, the capillary can be designed 
to any length necessary by choosing an appropriate bore diameter.  
The cost of material might warrant the use of an extension of anoth-
er material, e.g. common vinyl tubing.  This can be accomplished as 
long as the extension is added to the vacuum side of the capillary:
 
	

Fig. 5-6. Good and bad methods of adding an extension of vinyl 
tubing to the capillary.

The incorrect approach above will destroy the response time of the 
instrument.  At 1 ml per minute, it would take 33 minute for gas to 
travel from the inlet to the UGA.  The correct approach would take 
less than 2 seconds.  The decrease in pressure causes the volumetric 
flowrate to increase 1000 times as the gas travels through the capil-
lary. The flow in the extension is viscous, which implies that only 
diffusion will cause mixing in the axial direction.  Sudden changes 
in composition at the inlet will be detected as sudden changes at 
the UGA.  The response is simply delayed by the amount of time it 
takes to traverse the extension.  Only very long extensions should 
show any mixing.  For extensions, the general rule is to get the be-
ginning of the capillary as close to the sampling point as possible.
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General RGA information

Dawson, “Quadrupole Mass Spectrometery and Its Applications”, 
AIP Press, NY, 1995.
Drinkwine and D. Lichtman, “Partial Pressure Analyzers and Anal-
ysis”, AVS Monograph Series published by the Education Commit-
tee of the American Vacuum Society
Basford  et. al., J. Vac. Sci. Technol., A 11(3) (1993) A22-40: “Recom-
mended Practice for the Calibration of Mass Spectrometers for Par-
tial Pressure Analysis. Update to AVS Standard 2.3”.
Batey, Vacuum, 37 (1987) 659-668: “Quadrupole Gas Analyzers”
Fu Ming Mao et. al., Vacuum, 37 (1987) 669-675: “The quadrupole 
mass spectrometer in practical operation”
Dawson, Mass Spectrometry Reviews, 5 (1986) 1-37: “Quadrupole 
mass analyzers: Performance, design, and some recent applica-
tions”

Vacuum Diagnosis

Studt, R&D Magazine, October 1991, p. 104: “Design Away Those 
Tough Vacuum System Riddles”
Applications of RGAs to process control
O’Hanlon, J. Vac. Sci. Technol. A 12 (4), Jul/Aug 1994: “Ultrahigh 
vacuum in the semiconductor industry”
Vic Comello, R&D Magazine, September 1993, p. 65: “Process Mon-
itoring with “Smart” RGAs”
Waits, et. al., Semiconductor International, May 1994, p. 79: “ Con-
trolling your Vacumm Process: Effective Use of a QMA”
Rosenberg, Semiconductor International, October 1995, p. 149: “The 
Advantages of Continuous On-line RGA Monitoring”.
Lakeman, Semiconductor International. October 1995, p. 127: “In-
crease overall Equipment Effectiveness with In Situ Mass Spec-
trometery”.

Quantitative measurements

Bley, Vacuum, 38 (1988) 103-109: “Quantitative measurements with 
quadrupole mass spectrometers: important specifications for reli-
able measurements”
Cowen, et. al., J. Vac. Sci. Technol. A 12(1), Jan/Feb 1994: “ Non-
linearities in sensitivity of quadrupole partial pressure analyzers 
operating at higher pressures”

5.4	 References
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Multiple linear regression analysis algorithms
William H. Press, et. al., 1992, Numerical Recipes in C, The Art of 
Scientific Computing, Second Edition, Cambridge Univ. Press, sec-
tion 15.4, page 671.
Bevington, P.R., 1969, Data Reduction and Error Analysis for the 
Physical Sciences, New York, McGraw-Hill, Chapters 8-9.
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Appendix A

UGA Menu Table
(* The bold value is the factory default value.) 

Top level 2nd level 3rd level 4th level 5th level 6th level
Leak Test Off : Stop Leak test & go to the selected display

On : Start Leak test & go to the Leak Test display
Mass Selection Input data (4 amu, 1 - 100) & one level up
Audio Volume Select a state (Off, Low, Medium, High) & one level up
ElectronMultiplier Select a state (Off, On) & one level up

System Bake Off : Stop System baking & go to the selected display
On : Start System baking & go to the System Bake display
Bake Time Input data (8 hr, 2 - 100) & one level up
Bake Temperature Elbow Input data (105, Off - 120) & one level up

Chamber Input data (105, Off - 120) & one level up
Communication RS232 Baud rate Select a parameter (28800, 38400) & one level up

IP Address Input data (0.0.0.0) & one level up
Subnet Mask Input data (255.255.255.0) & one level up
Gateway Input data (0.0.0.0) & one level up
Login Name Input data (SRSUGA) & one level up
Password Input data (SRSUGA) & one level up

Display Pressure Select a unit (Torr, Pascal, mbar, bar) & 
       go to Pressure Display (default during the operation)

Turbo Pump  :   Go to Trubo Pump Display
Temperature   :   Go to Temperature Display
Leak Test   :   Go to Leak Test Display
System Bake   :   Go to System Bake Display
About UGA   :   Go to Introduction Display (default for the Off state)

Controls Roughing Pump Off : Turn off RP & go to the selected display
On :  Turn on RP & go to the selected display
Idle : Set RP idle & go to the selected display
Tune On-Power Input data (60 %, 30 - 100) & one level up
Tune Idle-Power Input data (45 %, 30 - 100) &  one level up
Vent Valve Close : Close the vent valve & go to the selected display

Open :  Open the vent valve & go to the selected display
Auto Vent Valve Select a state (Off, On) & one level up

Bypass Pump Off : Turn off BP & go to the selected display
On :  Turn on BP & go to the selected display
Tune On-Power Input data (60 %, 30 - 100) & one level up

Turbo Pump Select a state (Off, On, Idle) & go to the selected display
Bypass Valve Select a state (Close, Open) & go to the selected display
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Top level 2nd level 3rd level 4th level 5th level 6th level 
Controls (contin-
ue...) 

Sample Valve Close : Close the sample valve & go to the selected display 

Open :  Open the sample valve & go to the selected display 

Auto Sample Valve Select a state (Off, On) & one level up 
Vent Valve Close : Close the vent valve & go to the selected display 

Open :  Open the vent valve & go to the selected display 

Auto Vent Valve Select a state (Off, On) & one level up 

RGA Select a state (Off, On) & go to the selected display 
Ion Gauge Off : Turn off IG & go to the selected display 

On :  Turn on IG & go to the selected display 

Degas : Start degassing IG & go to the selected display 
IG Fil Select Select a parameter ( Fil 1, Fil 2) &  

     one level up 
Heaters Off  : Turn off all the heaters & go to the selected display 

Bake : Turn on Baking heaters & go to the selected display 

Heat Sample : Turn on Sample heaters if installed & go to the selected display 
Set Temperatures Bake Tempera-

ture 
Elbow Input data (105, Off, 40-120) & 

   one level up 
Chamber Input data (105, Off, 40-120) & 

   one level up 
Sample Tem-
perature 

Elbow Input data (Off, 40-120) & 
   one level up 

Chamber Input data (Off, 40-120) & 
   one level up 

Sample Line Input data (80, Off, 40-80) &
   one level up 

Capillary Input data (80, Off, 40-80) &
   one level up 

MultiInlet Channel Select a channel (Not Installed for no Option#1, present Channel # for Option #1) &     go to the 
selected display 

Pressure Interlock Select a state (Off, On) & one level up 
Auto Start :  Perform the Start sequence & go to the selected display 

Sleep :  Perform the Sleep sequence & go to the selected display 

Stop  :  Perform the Stop sequence & go to the selected display 
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Appendix B

The state diagram is shown below.  Each arrow means a state can be 
reached from the state which an arrow starts.  For example, BAKE state 
(12) can be reached from READY, IDLE, INDIVIDUAL, and OFF.  And 
LEAK TEST function can be reached only from READY, not from any 
other states.  But during LEAK TEST, the system can go to STOP.  As can 
be seen below, all fundamental modes can be reached from another.   The 
UGA can be stopped from any condition.  The stop command is handled 
on an emergency basis. 

	   3 : Starting (Preparing for Ready state)
	   4 : Stopping
	   7 : Sleeping
           	 11 : Going to the Bake state

     	 Refer to Chapter 3 for the other state numbers.

UGA State Diagram

 7 

:  Changes to READY state when the mode ends. 

IDLE  :  8       READY  :  6 

INDIVIDUAL  :  13 

OFF  :  1 

BAKE  :  12 

LEAK TEST : 10 

4 

4 

4 

3 

4 

4 

3 

3 

7 

11 

11 

11 

11 

:  Change to IDLE from INDIVIDUAL only when TP is at full speed 
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Appendix C

Calibration Log for RGA

SRS serial number ___________

In the table below are the results of the calibration of the inlet and capillary. The factor is entered
in the pressure reduction settings dialog box (under the Utilities menu) in the software. Al-
though the RGA software will store the value for you, a written record is recommended.

              
performed by capillary ID length P high side test gas factor
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